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About This Manual This manual introduces you to the Apple® Macintosh rM 512K enhanced 
computer. Use it now to learn the basic Macintosh skills, and pick it up again 
later to use as a reference. You don't need to know anything about the 
Macintosh 51 ZK enhanced or any other computer to use this manual. And you 
won't have to keep learning new ways of doing things. Once you've mastered a 
few new techniques, you'll use them whenever you use your Macintosh 512K 
enhanced. 

You can also take a guided tour of Macintosh by listening to the cassette tape 
(use it in any cassette player) along with the Guided Tour disk. In the guided 
tour, your Macintosh 512K enhanced demonstrates itself, introducing-in a 
different way-the same skills this manual teaches. 

This manual tells you how to 

o use the mouse and keyboard to control your Macintosh 51 ZK enhanced 
(Chapter 1) 

o get started with your own work, make changes to it, and save it (Chapter 1) 

o organize and manage your documents and disks (Chapter 2) 

o understand the general way Macintosh works no matter what application 
you're using (Chapter 3) 

o get the most out of your Macintosh 51 ZK enhanced system by adding other 
products to it (Chapter 4) 

o care for your Macintosh 512Kenhanced (Chapter 5) 

o do simple troubleshooting and find further help (Chapter 5) 

How to Use This Manual 
Read Chapter lto learn the basics and to get started using one of the application 
programs you probably purchased along with your Macintosh 51 ZK enhanced. 
Then continue on with this manual or go to the manual that came with the 
application you' re going to use. Return to Chapter 2 of this manual when you 
want to know more about organizing your work. Use Chapter 3 for reference. 
Read Chapter 5 soon after you get your Macintosh 512K enhanced to learn how 
to care for it. 

The appendixes contain technical information. A glossary of Macintosh terms 
and an index are also included. 

Now turn to the first chapter and get started. 
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Introduction You 're about to learn a new way to use a computer. If this is your first 
experience with a computer, you're starting at a great time. If you've used 
"traditional" computers, you 'II really appreciate the Macintosh difference. 
No more guessing what the computer wants. No more memorizing long 
commands with names only a programmer could love. With Macintosh, 
you're in charge. 

Macintosh removes a lot of the mystery about using computers. Every action 
you take has an effect you can see-so you ' re always in control of what 
happens. And you don't have to keep tedious details in your head, because 
Macintosh keeps track of them for you. You ' re free to think about what you 
want to do rather than how to get your computer to do it. 

This chapter teaches what you need to know to use your Macintosh 512K 
enhanced-how to create documents (the name for anything you create 
with Macintosh), make changes to them, and put them away. It all happens 
with a few basic techniques, the same Macintosh techniques you' II use 
whenever you work with any application on your Macintosh 512K 
enhanced. 
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Meet Your 
Macintosh 512K 
enhanced 

Before you start , make sure you attach the power cord to the main unit of 
your Macintosh 512K enhanced, and plug the other end into a grounded 
outlet. Then attach the keyboard and mouse to the main unit. 

• Switch the Macintosh 512K enhanced on if it's not already on. 

A beep lets you know it's started, and a yellow plastic piece pops out of the 
disk drive. The Macintosh 512K enhanced lets you know this isn't a 
Macintosh disk. But don't discard the plastic piece; inserting it in the disk 
drive prevents damage during shipping if you ever need to transport your 
Macintosh 512K enhanced a great distance. 

An icon (a small picture) representing a Macintosh disk appears on the 
screen. The blinking question mark shows that the Macintosh 512K 
enhanced is ready for you to insert a disk. 

r.JF--= 
l prccn8CG9GRllDOO'f I 
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• Insert the disk labeled Macintosh 512K enhanced System Tools into the 
disk drive, metal end first, label side up. 

When the disk is most of the way into the disk drive , the Macintosh 512K 
enhanced automatically pulls it in, and the disk "kerchunks" into place. 
The soft hum is your Macintosh 512K enhanced getting information from 
the disk. A message appears , welcoming you to Macintosh. 

• Adjust the brightness control to the level you want. 
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6 

A few seconds later, your screen looks like this: 

Icon --------+--

This is the Macintosh desktop. Most computer screens look like the 
departing flight schedule at a busy airport, but the Macintosh 512K 
enhanced screen looks like a light gray desktop. And you can arrange your 
desktop anyway you want. You can slide documents around, organize your 
work in folders , throw things away, or get what you want to work on next­
just by moving the mouse and pressing the mouse button. 

You use a special application called the Finder to work on the desktop. 
You 'll learn more about the Finder later in this chapter. 

The bar at the top of the screen contains menus; you' 11 see how to use them 
a little later also. The icons on your desktop always let you know what's 
available . Right now you see icons that represent 

o the System Tools disk you inserted 

o the Trash, where you can discard what you don't need anymore 

If your screen doesn't look like this, someone else has probably used this 
lesson and arranged the desktop in a different way. After you learn in the next 
section how to use the mouse, see "Handling Windows" in Chapter 2 to 
close all windows that may have been left open. 
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Using the Mouse 

II Moving the 
Pointer by 
Moving the 
Mouse 

Your Macintosh 512K enhanced responds instantly to every movement you 
make with the mouse. You can start applications and get documents, work 
on them, and put them away again-just by moving the mouse and pressing 
the mouse button. The best way to see how this works is to try it. 

·.~, 

.... ~"~ - - .:r- :.. , , .. ", 

' 
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• Watch the screen while you roll the mouse on a flat surface next to your 
Macintosh 512K enhanced. For now, don't press the mouse button. 

Every move you make with the mouse moves the pointer in exactly the same 
way. Usually the pointer is shaped like an arrow, as it is now, but it changes 
shape depending on what you're doing. For instance, it becomes an I-beam 
when it 's positioned over text you can edit, or a wristwatch when your 
Macintosh 512K enhanced is doing something that takes a little time. 

You'll have the best control if you hold the mouse with the mouse cable 
pointing directly away from you. 

If you run out of room for the mouse-if it goes off the table , for instance, or 
runs into the Macintosh 512K enhanced itself-lift the mouse and put it 
down again where you have more room. Lifting the mouse doesn't move the 
pointer. 

Using the mouse might feel a little awkward at first , but it will soon be 
second nature. 
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~ Selecting by 
- Clicking an Icon 

You probably have your own idea of how your desktop should be organized, 
so the first thing to do with your mouse is arrange your electronic desktop to 
suit you. To move an icon, you first select it to let your Macintosh 512K 
enhanced know this is what you want to work on next. You select icons 
using a technique called clicking. 

• Position the pointer on the Trash icon. 

Make sure the tip of the pointer is on the icon. 

• Click the icon by pressing and immediately releasing the mouse button. 

As you click the icon, it's highlighted. What was black is now white and vice 
versa. The highlighting shows that you selected it. Notice that the System 
Tools icon is no longer selected. Selecting is an important idea with 
Macintosh, and it has a specific meaning: you always select the information 
you want to work on next. 

• Click the System Tools icon. 

Now the System Tools icon is selected, and the Trash icon is no longer 
selected. 
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m Dragging an 
• icon 

When clicking, try not to move the mouse as you release the mouse button. 
Practice clicking each icon in turn until you can click without moving the 
mouse at all. 

Once you've selected an icon, you can use the mouse to move it with 
a technique called dragging. 

• Position the pointer on the Trash icon. 

• Press and hold the mouse button while you move the mouse. 

When you press the mouse button, you select the icon. As you move the 
mouse, the pointer moves and drags an outline of the icon and its name 
along with it. So you always know where you were-and where you're 
going. 

• Release the mouse button. 

The icon snaps to its new place. 
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Try this again with the System Tools icon. Move the icon all the way to the 
left. Notice that it won't go off the edge of the screen, so you don't have to 
worry about losing it. Remember, lifting the mouse has no effect on what 
you're doing (but releasing the mouse button does end the current 
dragging). You can cancel a drag in process by moving the pointer into 
the menu bar at the top of the screen. Practice dragging until you can easily 
put the icons wherever you want them. 

You've learned how to use the mouse to point to and select information you 
want to work on, and you've seen how you can drag icons to arrange your 
desktop. Next you'll learn how to act on what you select by choosing a 
command from a menu. 

By the way, you can take a break from this lesson at any point. Leave the 
Macintosh 5 l 2K enhanced switched on and pick up where you left off. If the 
Macintosh 5 l 2K enhanced has been switched off, switch it back on, make 
sure the System Tools disk is inserted, and start over. 
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Selecting and 
Choosing 

II Selecting the 
System Tools 
Icon 

fl Pulling Down a 
Menu 

Whenever you work with your Macintosh 512K enhanced, you tell it two 
things: what you want to work on, and what you want to do. First, you tell the 
Macintosh 512K enhanced what you want to work on by selecting it as 
you've been doing with icons on the desktop. Then you tell the Macintosh 
512K enhanced what you want to do with the selection. You usually do this 
by choosing a command from a menu. 

What you now want to work on is the System Tools disk, and what you want 
to do is open its icon so you can examine its contents. Follow these steps. 

• Position the pointer on the System Tools icon and click. 

This is the same thing you've done before. Now the System Tools icon is 
selected, and you can choose a command for it. 

Along the top of the screen, in the menu bar, are titles of the menus you can 
choose from. 

Edit Uiew Special 

:•:N 
3€ 0 

Prin t 
r lose 

Get Info 3€ 1 
Ouptic<11e :•:n 
Put HUHHJ 

PtHj!~ Selup 
t>rin t r 11 tatoq 

Eject 3€ E 

• Position the pointer on the word "File" in the menu bar. 

Among other things, the File menu lets you open icons. 

• Without moving the mouse for now, press and hold the mouse button. 
Release it when you're finished looking. 
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m Choosing a 
- Command 

From a Menu 

12 

Pressing the button while you're pointing to a menu title causes the title to 
be highlighted and a menu to appear. The menu contains commands you 
can carry out on what you've selected. Commands that you can't use right 
now (Close, for instance) appear dimmed in the menu . When you release 
the mouse button, the menu disappears . 

To choose a command from a menu, you use the same dragging technique 
you used to move icons. 

• Position the pointer again on the menu title "File" in the menu bar. 

• This time, press the mouse button and hold it down while you drag the 
pointer to the word "Open," and then release the mouse button. 

nup!ic<i1(o 
- --- ·- t.....1~U.!lHt __ _ _ 

When you release the mouse button with the Open command highlighted, 
an outline zooms out of the icon and the screen is almost filled by a window. 
This window displays a directory of icons that represent the contents of the 
System Tools disk. 

If a window doesn't appear, make sure the System Tools icon is selected 
before you choose Open from the File menu . 

The System Tools icon is hollow now to show that the icon has been opened 
into a window. 

As you drag through a menu , each usable command is highlighted in turn. 

If you change your mind about choosing a command, you can move the 
pointer off the menu . Nothing is chosen unless you release the mouse 
button while one of the commands is highlighted. 
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System Folder 

Zoom box -------+- *-------------/ 
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Hollow icon ------+----El================~:.U 

Size box -------+--

The System Tools window's title appears in the title bar at the top of the 
window. Below the title bar is information about the directory's contents. 
Along the right and bottom are scroll bars that let you get around in large 
directories or documents. In the bottom-right corner is the size box you 
use to change the size of a window. At the top left is a close box and at the 
top right is a zoom box that zooms the window out so it nearly covers the 
screen. In a few minutes, you'll see how to use these parts of a window to 
manipulate it. 

To sum up what you've done so far: First you selected something (the 
System Tools icon), and then you chose a command (Open). You'll follow 
this same pattern whenever you work with Macintosh 512K enhanced: 
Select some information, then choose an action for it. 

There are two icons in the System Tools window, representing folders that 
are on the System Tools disk you inserted into the Macintosh 512 K enhanced 
drive. One of the folders holds system information the Macintosh 512K 
enhanced needs, and the other contains special utility programs you'll use 
later, when you 're an experienced Macintosh user. 
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Manipulating 
Windows 

II Changing the 
Size of a 
Window 

When you're working on a document on your desktop, it's great to have 
a wide-open window on it so you can really see what 's there . But small 
windows also have their advantages. You can move small windows around 
on your desktop, and you can see more than one at a time . To change a 
window's size, you use the size box in the bottom right corner of the 
window. 

Zoom box -------;---

14 

2 items 425K in disk 
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• Position the pointer on the size box, and drag it up and to the left. 

As you drag, a dotted outline follows. The farther to the left you drag, the 
narrower the outline becomes; the farther upward you drag, the shorter it 
becomes. When the outline's as small as you can make it, it stops moving. 
When you release the mouse button , the window changes size. 

The contents of the window don't change at all when you change a 
window's size. The only thing that changes is how much you can see. 

• Position the pointer on the zoom box and click. 

The window zooms out to nearly fill the screen. 
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~ Movinga 
- Window 

• Click on the zoom box again. 

The window returns to its former size. Using the zoom box lets you use 
every square inch of the screen for what you're currently working on and, 
with a single click, bring everything that's on your desktop back into view. 

Experiment with controlling the size of the System Tools window. Drag the 
size box down and to the right to make the window bigger again. Then try 
all different lengths and widths. Use the zoom box and notice how the 
Macintosh 512K enhanced always shrinks the window back down to 
whatever size it was when you zoomed it out or whatever size you changed it 
to using the size box. 

You can move windows on your desktop just as you moved icons. To move 
a window, you drag it by its title (or anywhere in the horizontal title bar at 
the top of the window). Don't, however, drag it by the zoom box or the 
close box, the small box in the title bar; the close box is just for closing the 
window. 

• Position the pointer anywhere on the title of the System Tools window. 

• Drag the System Tools window by pressing the mouse button and 
holding it down while you move the mouse. 
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m Opening 
- Another Icon 

II Making a 
Window Active 

16 

Just as when you dragged icons, a dotted outline of the window follows your 
movements. When you release the mouse button, the window moves where 
the outline was . 

If you release the mouse button before you have the window where you 
want it, just "pick the window up" again. If you change your mind about 
moving it, cancel the drag by moving the pointer into the menu bar. 

Just as icons stayed within the limits of the desktop, so do windows. You can't 
lose them by dragging too far. 

Practice your new skills. When you can manipulate the window easily, 
making it any size and putting it anywhere you want on (or partially off) 
the desktop, go on to the next step. 

Use your new window-handling expertise to get the System Tools window 
out of the way if you need to. Shrink it down and move it around so you can 
see the Trash icon. 

• Open the Trash icon. 

Use the same technique you used a few minutes ago. Select the Trash icon 
by clicking it, and then choose Open from the File menu by positioning the 
pointer on the menu title , pressing the mouse button, dragging to the Open 
command, and releasing the mouse button. 

A second window appears on the desktop, probably overlapping the first 
(depending on where you left the first window and what size you made it). 

With Macintosh you can have many windows on your desktop at the same 
time. When there 's more than one window, your Macintosh 512K enhanced 
needs to know which one you ' re working on at the moment, so that the 
commands you choose and the text you type end up in the right place. 
The window you're working on is always in front of all the others. It's called 
the active window, the place you want the next action to happen. 
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The active window's title bar is highlighted with narrow horizontal lines 
on either side of the title. The active window usually has a size box in the 
bottom right corner and scroll bars on the right and bottom sides. 

425K in disk 

System Folder 

Trash 
0 items 

Active window-----------

When you opened the Trash icon, it automatically became the active, 
frontmost window-the window you 're working in. The System Tools 
window is also open on the desktop, but it's no longer the active window. 
To work in the System Tools window again, you make it active by clicking 
anywhere inside it. 

If you left the System Tools window small before you opened the Trash 
window, it may be completely hidden by the Trash window now. You know 
how to move windows and change their size, so if you can't see the System 
Tools window, move the Trash window or change its size until you can see 
the System Tools window again. It doesn't have to be completely visible; 
as long as you can see part of it, you can make it active. 

Manipulating Windows 17 



18 

•Click in the System Tools window. 

The window is brought to the front of the desktop; its title bar is highlighted, 
and scroll bars and a size box appear to show it 's the active window. 
Whenever you want to work in a window that isn 't already active, 
you first make it active by clicking in it. 

425K in disk 

v 
System Folder 

0 items 

Your desktop might not look exactly like the one here. Your Macintosh 512K 
enhanced does exactly what you tell it to do; the size and position of your 
windows are up to you. 

• Click in the Trash window. 

Now it moves in front of the System Tools window again. 

Experiment with arranging your desktop-making each window active 
in turn, changing its size, and moving it. 

Notice that you sometimes need to move a window in order to see its size box. 
And you sometimes need to change a window's size or move it to see a 
window it's covering. By the way, moving a window also makes it active if it's 
not already, so you don't have to make a window active before you move it. 

Chapter 1: Leaming Macintosh 



~ Opening Other 
- Icons 

You can open icons in a directory window, such as the System Tools 
window, just as you opened icons on the desktop. You know how to open 
an icon by selecting it and choosing Open from the File menu. There 's 
a shortcut: you can do the same thing with a technique called double­
clicking. Try it to open the System Folder icon in the System Tools window. 
(If necessary, first make the Trash window smaller; then make the System 
Tools window active and large enough that the System Folder icon is 
visible.) 

• Position the pointer on the System Folder icon and quickly press and 
release the mouse button twice. 

a File Edit Uiew Special 

System Tools 
2 Hems 425K in disk 

0 
Utilities F o Ider 

System Folder 
8 items 425K in disk 

~ ~ ~ ~ - ~ 
System Finder Image Writer Scrapbook Fil~ Clipboard File 

LaserWrlter Laser Prep AppleTalk lmage'w'riter 

Inside the System Folder are icons that represent system files that contain 
information the Macintosh 512K enhanced needs. If the System Folder 
window doesn't appear when you double-click, speed up your clicking. 
That way the Macintosh 512K enhanced will be able to interpret your 
actions as a double-click, and not just as insistent single clicks. Now you 
have two ways to open icons. 
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(;WI Closing a 
• window 
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• Open the Utilities Folder icon, either by double-clicking it, or by 
selecting it and choosing Open from the File menu. 

If necessary, first move the System Folder window. The Utilities Folder 
contains icons that represent utility programs and other items you'll use 
later. 

You can have many windows on your desktop, but to keep things tidy, you 
might want to close some when you're finished working on them, and open 
them again when you need them. 

• Make the Trash window active by clicking in it. 

• Choose Close from the File menu. 

Get Info 3€ 1 
llupiic<11 e :$:[! •---U-t-il-it-ie_s_F o-1-de_r ___ ~ 
l'ut Humq 

Page Setup 
Print Catalog 

425K m disk 

A 
· ······ ·· ·· ··················· ··· ID A Mover Fon ts Desk Accessor-ies 

D Eject 11€ E - Trash 

0 items 

The window collapses back to an icon. Whenever you choose Close from 
the File menu, the frontmost, active window is closed, and the next window 
behind it becomes active. 

Now close the Utilities Folder window using another shortcut. The close 
box in the title bar lets you close an active window with a single click. 
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II Using the Scroll 
Bars to See 
More 

• Make the Utilities Folder window active if it's not already. 

• Click the close box. 

s File Edit Uiew Special 

System Tools 
2 items 425K in disk 

It's the same as choosing Close from the File menu . 

Most of the time, a window on the desktop can't show you the entire 
directory or document all at once, even when you 've made the window 
very large . There 's often more information than can fit in the window at 
one time . 

........ 1 ... -01 
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The scroll bars in an active window let you move what's in the window so 
you can see more of it. 

• Make the System Folder window small enough that some of the icons are 
hidden from view. 

s File Edit Uiew Speci11I 

System Tools 
2 items 425K in disk 

0 
Utilities Folder 

§0~ System Folder ~0§ 
8 items 425K in disk 

rn 
~ 
Finder 

rn 
~ 

• Click the scroll arrow that points to the right. 

More icons come into view. You can also scroll left, up, or down. 

If you want to know more about scroll bars, see "Scrolling" in Chapter 2. 
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Using an 
Application 

II Creating a New 
Document 

You might be wondering what all of this has to do with your work-the 
documents you'll create with Macintosh applications. First, you 'll use the 
skills you 've just learned whenever you work with your Macintosh 512K 
enhanced, in nearly all applications. You usually select information and 
choose commands in consistent ways. And windows are always opened and 
closed, changed in size, moved, and made active using the same techniques 
you've just learned. 

Second, this chapter introduces the Finder, the application you use to 
organize and manage your documents. The Finder is available every time 
you start your Macintosh 512K enhanced or whenever you move from one 
application to another. In fact , you 've been using the Finder all along. 

In addition to helping you manage your documents-copying them, 
renaming them, removing them, for example-the Finder lets you start 
applications and get documents, and then put your documents away 
when you've finished working on them. 

Disks that contain the Finder and System file are called startup disks. 
(The Finder and other system files are in the System Folder.) You always 
start your Macintosh 512K enhanced using a startup disk. 

You probably purchased an application or two along with your Macintosh 
512K enhanced. Each Macintosh application disk is also a startup disk, just 
as the System Tools disk is . Keep the System Tools disk as a spare copy of the 
system files in the System Folder and for when you want to use the utilities in 
the Utilities Folder. 

• Close first the System Folder window, and then the System Tools 
window. 

Use either of the methods you know-make the window active, and then 
choose Close from the File menu or click the close box. 

• Choose Eject from the File menu. 

The System Tools disk is ejected. 
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• Insert the application disk you want to use. 

A word processing application such as MacWrite TM or a graphics application 
such as MacPaint™ or MacDraw™ is a good choice to begin with. No matter 
what kind of work you do, you'll probably want applications that let you 
express yourself with words and pictures. 

A Macintosh application package may include two copies of the application 
disk. Put one of these away in case your working copy ever becomes 
unusable. If this does happen, make a copy of the spare to replace your old 
working copy. (See Chapter 2 to find out how to copy a disk.) That way 
you'll always have a spare copy. 

Some applications' startup disks may have earlier versions of Macintosh 
system software. You can check by choosing Shut Down from the Special 
menu and restarting the Macintosh 512K enhanced with the application 
disk by inserting it when the question mark icon appears. Choose About the 
Finder from the Apple menu on the far left side. The Finder should be 
version 5.1 or later. Updating each of your application disks ensures that 
each disk has the same system software your Macintosh 512K enhanced 
System Tools disk has. If you don't update the application disk, things will 
probably look a little different from what this tutorial describes. See ''Using 
the Installer'' in Chapter 2 for how to update your application's startup disk. 

• Open the icon that represents the application disk, either by double­
clicking it, or by selecting it and choosing Open from the File menu. 

The System Tools icon is still there, but it's dimmed to show it's not 
currently available. If the window was left open, its icons are dimmed. 

If you're using an external disk drive for your application disk, both disks 
are available. 
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r:9 Saving Your 
- Work on a Disk 

• Open the icon that represents the application you want to use. 

a File Edit Uiew Special 

Write 

3 Hems 328K in disk 

S.ample Memo 

0 
System Folder 

That's all there is to opening an application. 

• Do some work on your new document. 

You don't really need to know how to use an application to finish this 
chapter. For example, just use the keyboard to type your name with 
MacWrite or draw a squiggly line with MacPaint (position the pointer 
anywhere in the drawing window and drag) . You need to save only a 
small amount of work to see how the Finder helps you keep track of 
your documents . 

Whenever you 're finished working on a document, you decide whether you 
want to keep what you 've done or throw it away. 

• Choose Save from the File menu. 

A dialog box appears . 

Whenever your Macintosh 51 2K enhanced needs more information from 
you, it presents a dialog box, with buttons to click, such as OKorCancel, and 
sometimes with a place for you to type additional information. These 
messages can also alert you if you're about to do something that could cause 
you to lose information, giving you a chance to cancel what you were about 
to do. When alerting you, messages are often accompanied by a beep. 
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The dialog box that appears now gives you the chance to save your 
document on any disk. If the disk is initialized on both sides, you see folders 
on the disk and can save your document in one of the folders . If the disk is 
initialized on one side only, you don't see any folders. For now, you 'll save 
your document on the current disk, without placing it in a folder. You can 
find out about using folders within applications in Chapter 2, ''Using the 
Installer" and "Using Folders. " See "Initializing Disks" in Chapter 2 for 
information about initializing. 

There 's a space for you to type the name of your document. A blinking 
vertical bar marks the insertion point, where text you type will be inserted. 

l(gj Write I 

l"~ lm<19(~HJriler 

~ !'>·l<!( UJritt~ 

D NPwHle 

Saue Current Document As 

J [Sar~]._ 
Insertion point------ --7 

Cancel J 

(gj Write 

Eject 
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W1!lfi 
@ Entire Document 0 TeHt Only 

The main part of the Macintosh 512K enhanced keyboard is very similar to a 
typewriter keyboard. Use the Shift key for capital letters. If you make a 
mistake, use the Backspace key to erase characters back to where the 
mistake is, and then start typing again. 

• Use the keyboard to type your name or any other name you want to give 
your document. 

• Click Save. 

Your document is saved on the disk just as it is now. Make a habit of choosing 
Save about every 15 minutes or so while you' re working with your 
Macintosh 512K enhanced. (It 's a good thing to do while you 're waiting for 
your next inspiration.) That way, if your Macintosh 512K enhanced gets 
switched off or there 's a power failure , you 'll never lose more than 15 
minutes' worth of work. 

With your work saved on the disk, you can leave the application you 've been 
using and return to the Finder. 
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IC1I Editing Text: 
- Cutting and 

Pasting 

• Choose Quit from the File menu. 

The desktop appears again. But now the icon of your new document appears 
in the application disk window. 

MacWrlte Sarah Sample Memo 

This new icon represents the document you created, and below it is the 
name you gave it. All documents you create with an application have that 
application's icon, so you can tell which application you used to create each 
of your documents. The next time you want to work on this document, 
you select and open it just like any other icon. Opening the document you 
want to work on also starts the application you need to do the work. 
You don't have to open the application, and then open the document; once 
a document's been saved, you can open it directly from the Finder. 

The Macintosh 512K enhanced keyboard is mainly for typing text and 
numbers. You'll see the way you 'll usually type and edit text, no matter 
which application you ' re using, by adding some comments about the 
document you just created. 

• Select the icon that represents your document. 

• Choose Get Info from the File menu. 

An information window appears, showing some useful information about 
this document, such as which disk it's on, how big it is, and so on. 

There's also room for you to add comments about the document. Having 
comments here will save you time when you want to know more about a 
document without opening it. You might have a note explaining that this is 
your smash-hit sales presentation of last November, or the play that won you 
the Pulitzer Prize. Of course, you 'll also know by its icon which application 
you used to create the document. 
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The blinking vertical bar appears again, marking the insertion point for text 
you type. 

You 'll use the keyboard to add your comments. You don't have to press the 
Return key when you come to the end of a line of text; the next line starts 
automatically. 

•Type: 

.. ...... }~is is the fin:;t do.curnerit .1 c;re.ated.()n. rnY Mac;intos~ ~12K. .e.n~aric.e.d. 

. . . . . It hci~ great ~entirnental ycilue. . . . . . . . . . . . . . ....... .. ... .. .. 

Kind: 

Size: 

Where: 

Created: 

Uiew Special 

Write 
Information about Sarah 

MacWrite document 

Sarah [I 
1329 bytes, accounts for 2K on disk 

Write, internal driue 

Tuesday, September 24, 1985 at 5:01 PM 

Modified: Tuesday, September 24, 1985 at 5: 11 PM 

D Locked 

This is the first document I created on my Macintosh 
512K enhanced. It has great sentimental ualue~ 

You can edit your comments by cutting and pasting with the Cut command 
and the Paste command. First, select some text to cut. 

• Position the pointer at the beginning of the word "great" and drag to the 
end of the word. 

You ' re selecting information to work on, as you did when you selected 
icons. You selected icons by clicking them; you select text by dragging 
across it. 
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If you move the pointer off the word, you might select more than the word 
''great''. If this happens, just start selecting over again; nothing unexpected 
can happen while you 're just selecting. 

This is the first docum~ated on my Macintosh 
512K enhanced. It has D'fiililllsentimental ualue. 

• Choose Cut from the Edit menu. 

The word ''great'' vanishes and in its place is the insertion point, where new 
text you type will be inserted. 

Whenever you choose Cut or Copy from the Edit menu , whatever you cut or 
copy is put in a holding place called the Clipboard, ready for you to paste it to 
a different location if you want. 

•Type: 

.... ..... (l~SOlljtely 1)0 .. 

What you type appears at the insertion point. 

• Select a new insertion point by clicking after the space following the 
word "first". 

This is the first ldocument I created on my Macintosh 
512K enhanced. It has absolutely no sentimental ualue. 
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• Choose Paste from the Edit menu. 

The contents of the Clipboard-the word "great", in this case-are pasted 
into the location you selected. You can add a space at the insertion point by 
typing one. See "Editing Text" in Chapter 2 for a summary of how to enter 
and edit text. 

The contents stay on the Clipboard until you choose Cut or Copy again, 
so you can continue to paste them. You can paste within one document or 
between two documents created with the same application. The contents 
also stay on the Clipboard when you leave an application, so you can cut and 
paste between applications. 

For example, you can draw a picture with MacPaint and use it to jazz up a 
report you create with Mac Write. Or borrow an especially eloquent passage 
from a MacWrite document and paste it into an overhead slide you 're 
preparing with MacDraw. 

Whether you 're using an application or the Finder, you can usually view the 
contents of the Clipboard. 

• Choose Show Clipboard from the Edit menu. 

The Clipboard window appears, with the word ''great'' in it. 

The Clipboard window doesn't have to be open for you to paste its contents. 

• Close the Clipboard window. 

Either choose Close from the File menu or click the close box. The Close 
command closes the active window, and close boxes appear only in active 
windows. 

• Close the information window. 
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Organizing 
Documents 

II Using Folders 

You 've seen how the Finder helps you start an application and get a 
document, save it , and leave the application. It also helps you organize 
your documents-grouping them together with related documents, 
duplicating them, renaming them, or throwing them away. 

You 'll soon accumulate many documents on the application disk you've 
been using. At some point you might want to arrange your desktop so that 
related documents are grouped together. Macintosh folders work just like 
ordinary file folders to help you organize your documents. For instance, 
you could keep all your monthly status reports together in one folder. Or 
group all your MacPaint illustrations together or keep each one with the 
report it illustrates. Macintosh lets you organize your documents however 
you want them (or keep them scattered about your desktop if clutter makes 
it easier for you to think). 

Information the Macintosh 512K enhanced system needs is grouped in the 
System Folder. To organize your own work, you have an endless supply of 
empty folders . 

• Create an empty folder by choosing New Folder from the File menu. 

Close 

Get Info 
Duplicate 
Put Hwnq 

sy Page Setup 
Print Catalog 

3€0 

3€ 1 
3€ 0 

-- ____ 4DJr-

Write 
330K in disk 

iJ -
mp le Memo 

A folder named "Empty Folder" appears in the active window. 
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Some applications may include an empty folder on the desktop; with these 
applications the folder you create is named ''Copy of Empty Folder.'' 

If there's no New Folder command in your File menu, you're probably using 
an application disk that hasn't yet been updated with new system software. 
To make the rest of this chapter work the way it's described, you must use the 
Installer to update your application disks with Macintosh 512K enhanced 
system software. See ''Using the Installer'' in Chapter 2. 

The empty fo lder is automatically selected when you create it , and you can 
rename it just by typing. If you can't see the entire icon, you can make the 
window larger or move the icon. 

•Type: 

Manila Folder 

"Empty Folder" is renamed "Manila Folder". 

Usually you explicitly click icons you want to rename. This prevents 
renaming highlighted icons when you don't really want to. But you don't 
have to click newly created folders to rename them. See "Renaming" in 
Chapter 2. 

You can also select, cut, and paste the icon names, as you did when you 
edited the comments about the document you created. Usually, however, 
when you want to rename an icon, it's easiest just to select the icon and 
replace the old name by typing a new one. 

• Drag the icon that represents the document you created to the Manila 
Folder icon, releasing the mouse button when the Manila Folder icon 
is highlighted. 

Special 

Write 
337K in disk 

MacW'rite 

0 
System Folder 
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~ Selecting More 
- Than One Icon 

When you cover the folder icon with the outline of the document icon, 
the folder icon is highlighted. When you ''drop" the document icon into the 
folder by releasing the mouse button, the folder icon is no longer 
highlighted. 

• Select and open the Manila Folder icon. 

There's the icon that represents your masterpiece. 

Dragging a document icon to a folder will file the document there. You can 
also drag an icon into an open folder window; the result is the same. 

Documents and applications can be left on your desktop as well as placed on 
disks or in folders on disks. You might want to leave the applications you use 
most often (or the documents you' re working on for a presentation that day) 
on the desktop so you can get at them easily from the Finder. 

Any application or document you leave on the desktop is automatically put 
back on its disk if you eject the disk. When you insert that disk again, 
whatever you left on the desktop reappears there. 

• Drag the icon that represents the application you were using out of the 
application disk window onto the gray desktop. 

Whenever you use this disk, this application will appear on the desktop 
where you left it. (Of course, you can also drag it back to the disk or leave it 
in the folder with your document.) 

You can take most actions on several documents at once. For example, you 
can move several documents from one place to another, discard them in the 
Trash, or find out information about them. One of the ways to select more 
than one icon is by using the dragging technique. 

• Make the application disk window open and active if it's not already. 

If it's closed and you open it, it automatically becomes the active window. 
If it's open but not the active window, click anywhere inside it to make 
it active. 

• Use the size box or the zoom box to make the window bigger so you'll 
have plenty of room. 
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• Position the pointer outside one corner of a group of icons (any corner) 
and drag diagonally to the opposite corner of the group. 

Be sure you start dragging outside an icon. If you position the pointer on 
an icon, you select just that icon. As you drag , a dotted rectangle appears 
around the icons you're selecting. When you release the mouse button, 
the icons are selected. You can select any group of icons that can be 
enclosed in a rectangle. 

a File Ellit Uiew Special 
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All icons you outline are selected. Now you can drag the whole group. 

• Position the pointer on one of the icons and drag the whole group to 
another part of the window. 

Make sure the pointer is on one of the icons (it doesn't matter which one) . 
They keep their arrangement and move in "formation. " The icons stay 
selected until you click anywhere outside any of them. 

You can also choose a command to act on a group of selected icons. For 
example, you can find out information about an entire group of documents. 
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• Choose Get Info from the File menu. 

An information window appears for each icon that's selected. As each new 
window appears on the desktop, it overlaps the window that appeared 
before it. 

You can move these information windows or make them active like any 
other windows on the desktop, but you can't change their size or scroll 
through them. 

• Close each information window in turn by choosing Close from the File 
menu or clicking its close box. 

Each time you choose Close or click its close box, the active window closes. 

There's another way to select more than one icon. Sometimes the icons you 
want to select aren't lined up in a way that you can drag a rectangle around 
them. If they're scattered about, you can select more than one by Shift­
clicking. 

• If necessary, open the application disk window. 

• Select any icon in it by clicking it. 

If any icons are still selected, first click outside of any of them before you 
select one again. 

• Hold down the Shift key on the keyboard while you click a second icon. 

The second icon can be any icon in the same window; You can even scroll to 
a different part of the window and Shift-click. 

You can continue to select more icons as long as you hold down the Shift key 
while you click. 

Any action you choose now will affect all the icons that are selected. You can 
choose a command for them or move them by dragging the whole group. 
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m Changing Your 
• view 

II Using a Desk 
Accessory 

You can use the Finder's View menu to look at your documents in whatever 
arrangement you want. 

• Choose By Name from the View menu. 

The contents of the active window are arranged alphabetically by name. 
You can also view them chronologically, by size, by kind, or with small 
icons that give you more space in the directory window. 

Macintosh desk accessories-an Alarm Clock and a Calculator, for 
example-are always available on the Macintosh desktop, no matter what 
application you ' re using or whether you ' re using any application at all. 

You choose desk accessories from the Apple menu on the left side in the 
menu bar. 

Chooser 
Control Panel 
Key Caps 
Scrapbook 

Special 

• Choose Alarm Clock from the Apple menu. 

0 5:15:40 PM 

Lever--------+-------' 

36 

• Click the "lever" on the right side of the Clock. 

The Alarm Clock expands to display and let you set whatever is highlighted 
in the bottom panel-the time, date, or alarm. 
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Time---------+--' 

Date --------+---' 

Alarm -------+--.....J 

m Starting Your 
- OwnWork 

You can click the icon that represents what you want to set, and then click the 
digits you want to change. Click the up arrow to advance the numbers, or 
click the down arrow to go backward. Click in the top panel to set. 

To display the simple Alarm Clock again, click the lever to return it to the 
horizontal position. 

See "Using Desk Accessories" in Chapter 2 and "Desk Accessories" in 
Chapter 3 for descriptions of the other accessories in the Apple menu . 

You probably have some work you want to use your Macintosh 512K 
enhanced for. If you'd like to know a bit more about Macintosh before you 
start using an application, read Chapter 3-' 'Reference. '' Be sure to use the 
Installer to update each startup disk, and then read the manual that came 
with the application you want to use. When you want some reminders or 
more information about using the Finder to organize your work, come back 
to Chapter 2 of this book-"Using the Macintosh 512Kenhanced." Enjoy! 
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Introduction This chapter summarizes the basic techniques you ' 11 use whenever you work 
with your Macintosh 512K enhanced-from clicking and dragging to using the 
desk accessories in the Apple menu. It also describes the steps to take when 
you want to use the Finder to manage your documents and disks . For example, 
it tells you how to move a document from one disk to another, how to copy 
a document or an entire disk, and how to remove documents (easy!). 

Although you' 11 use the Finder to do most of your document managing, 
you can also do a subset of these tasks while you're using an application. 
This subset is summarized here; see each application's manual for more 
detailed descriptions. 

You don't have to read this chapter in any particular order; each topic 
is independent of the others. 

a::s. 
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Summary of Mouse Techniques 

You can do all your work on the Macintosh 512K enhanced 
(except type text and numbers) with five mouse techniques: 

D click, to select or make active 

D press, to cause a continuous action 

D drag, to select or move 

D double-click, to open icons quickly 

D Shift-click, to extend or shorten a selection 

To click 

• Position the pointer on 
what you want to select or 
make active. 

• Press and quickly release 
the mouse button. 
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To press 

• Position the pointer on a 
menu title , a scroll arrow, or 
wherever you want the action 
to occur. 

• Without moving the mouse, 
press and hold the mouse 
button. 

As long as you hold down the 
mouse button, the effects of 
pressing continue. Pressing 
on scroll arrows results in 
continuous scrolling. 
Pressing on a menu title pulls 
down the menu and keeps it 
down until you release the 
mouse button. 



To drag 

• Position the pointer on 
something. 

• Press and hold down the 
mouse button , and move 
the mouse. 

• Release the mouse button. 

You can usually cancel a drag 
in process by moving the 
pointer back to where it 
staned. Cancel a drag in a 
menu by moving the pointer 
off the menu. Cancel moving 
an icon or window by moving 
the pointer into the menu bar. 

To double-click 

• Position the pointer on 
something. 

• Press and release the mouse 
button twice in quick 
succession. 

To Shift-click 

• Select something by 
clicking or dragging. 

• Hold clown the Shift key 
while you continue to select 
(or deselect) by clicking or 
dragging. 
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Handling Windows 

A window frames its contents. The contents may be a directory of 
a disk or fo lder, a desk accessory, or a document you create with 
an application. 

A window always has a title bar and may have 

D scroll bars 

D a close box 

D a size box 

D a zoom box 

Each application 's manual tells you more about windows 
in that application. 

To move a window 

• Position the pointer 
anywhere in the title bar of 
the window except the close 
box or zoom box (if any). 

• Drag the window to a new 
location. 

The window becomes the 
active window if it's nor 
already. 

To cancel the move, move the 
pointer into the menu bar. 
You can't drag a window off 
the desktop. 

To move a window without 
activating it, hold down the 
Command key whi le you 
drag. 

1~ 

Command key 

To activate a window 

• Click anywhere in the 
window. 

Activating a window brings 
it to the front , where it may 
overlap or completely cover 
other windows. To see 
covered windows, move 
the active window or make 
it smaller. 

~---···································· ····· .. ········-··-·· .. ···························-·····-·----·········-···········--·····································--..! 
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To change a window's 
size 

• Activate the window by 
clicking in it. 

• Move the window so that 
the size box in the bottom 
right corner is visible. 

• Drag the size box. 

Dragging horizontally 
changes the width, dragging 
vertically changes the height, 
and dragging diagonally 
changes both. The new 
dimensions take effect only 
when you release the mouse 
button. 

If there 's a zoom box in the 
window's top-right comer, 
you can click it to expand the 
window-clicking an 
expanded window's zoom 
box shrinks the window back 
to its smaller size. 

Some windows don't have a 
size box or a zoom box. 

s File Ed it Uiew Spe ci al 

System Folder 

To close a window 

• Activate the window by 
clicking anywhere inside it. 

• Choose Close from the File 
menu or click the close box 
on the left in the tit le bar. 

Some windows don't have 
a close box. 

711~~~~~~~~~~~~~~~~~ri"Sli~~---~~~~~l--~~~~~~~~~ Sizebox 
:.::....i~~~~~~~~~~~~~~~~~--'-'-"'"'I, I 

,, i 
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Scrolling 

Scroll bars let you see more of 
a directory or document's 
contents. 
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To scroll line by line 

• Click the arrow that points 
in the direction of what you 
want to see. 

You can scroll continuously 
line by line by pressing the 
scroll arrow. 

To scroll by the 
windowful 

• Click in the gray area of the 
scroll bar. 

You can scroll continuously 
by the windowful by pressing 
in the gray area of the scroll 
bar. 

Chapter 2: Using the Macintosh 5 I 2K enhanced 

To scroll quickly to any 
part of a directory or 
document 

• Drag the scroll box to a 
place in the scroll bar that 
represents the approximate 
position that you want to see. 

The scroll bar represents the 
length of the directory or 
document; for example, if 
you want to go to abom the 
middle of a directory or 
document , drag the scroll box 
to the middle of the scroll bar. 



Selecting Icons 

In the Finder, you select by 
clicking or dragging. 

See each application's 
manual for how to select 
information in that 
application. See "Editing 
Text" and "Renaming" in 
this chapter for more about 
how to select icon names 
and edit them. 

To select an icon To select more than one 
icon 

• Click anywhere on it. 

Clicking an icon's name also 
selects the icon. 

When they're grouped 
together: 

• Position the pointer outside 
one corner of a group of 
icons. 

8 i ems 

System 

8 ite-ms 

System Finder 

Selecting Icons 

• Drag to the opposite corner. 

Holding the Shift key down 
while you click a selected 
icon deselects it. 

tern Folder 
423K in disk 

lmage'w'riter- Scrapbook File Clipboard File 

tern Folder 
423K in disk 

~. ~ n 
WJ@4®'3:crapbook FileliifW 

When they aren't grouped 
together: 

• Select one icon by clicking. 

• Hold down the Shift key 
while you continue to select 
icons by clicking or dragging. 

Holding the Shift key down 
while you click a selected 
icon deselects it. 

You can Shift-click to select 
more than one item in 
directories you've arranged 
in text views. 

You can choose Select All 
from the Edit menu to select 
all icons in the active 
window. 

You can select more than one 
icon only when they're in the 
same window or they're all on 
the desktop. 
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Editing Text 

In the Finder, you can enter and edit 

D the names of disks, documents, folders , and applications 

D text in desk accessories such as Key Caps 

D text in the comment box of information windows (which you 
open by choosing Get Info from the File menu) 

See each application's manual for more on how to enter and edit 
text in that application. 

Edit Uiew Special 

3 ltems 

0 
System Folder 

Paint 
331 Km disk 

MacPaint 

Edit Uiew Special 

Paint 
331 Kin disk 

0 
System Folder MacPaint 

------ --

To insert text 

• Click to select the insertion 
point. 

You can also use the direction 
keys to move the insertion 
point. 

• Type to add text at the 
insertion point. 

When there's no existing text 
(sometimes in dialog boxes, 
for example) , the insertion 
point may already be 
selected. 

,Ill .... ~ 
Ted~ 
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To select text 

• Drag across the text 
(diagonally if there's more 
than one line) to the end of 
the text you want to select. 

OR 

• Double-click a word to 
select it quickly. 



To move text To copy text 

• Select by dragging across • Select the text by dragging 
the text. across it. 

• Choose Cut from the Edit • Choose Copy from the Edit 
menu . menu . 

• Select the insertion point by • Select the insertion point by 
clicking where you want the clicking where you want the 
text to go. copied text to go. 

• Choose Paste from the Edit • Choose Paste from the Edit 
menu . menu . 

s File Edit . Uiew SpeciBI 

. ~ote Pi!d 

~your mother 

- _____ .. : -- ---

Edit . ·Uiew SpeciBI 

tlrote Pi!d 

Mark--~~Tl your mother 
at worl( 

Editing Text 

To replace text To remove text 

• Select the text by dragging • Select the text by dragging 
across it. across it. 

• Type what you want to • Press the Backspace key or 
replace the text with , or choose Cut or Clear from the 
choose Paste from the Edit Edit menu . 
menu to replace the text with 
what was last cut or copied. If you 're really removing the 

text, rather than moving it, 
using the Backspace key is 
the fastest way to do it. 
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Using Desk 
Accessories 

Desk accessories are ''mini-applications'' you can use in the Finder or while 
you' re using any application. Desk accessories let you do simple calculations 
while you'reworking on a word processing document, tell the Macintosh 512K 
enhanced which printer to use , and even keep a scrapbook full of your favorite 
illustrations or boilerplates. 

You can use the Font/DA Mover to add or remove desk accessories from 
your startup disks. The desk accessories installed on a startup disk are available 
in the Apple menu whenever that disk is the current startup disk. See "Startup 
Disk" in Chapter 3. See "Using the Font/ DA Mover" in this chapter. The 
System Tools disk includes an accessory file with the Note Pad and the 
Puzzle-accessories you might want to add. 

This section explains how to use the Chooser, Control Panel, and the 
Scrapbook. See "Desk Accessories" in Chapter 3 for more information 
about other desk accessories. 
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Using the Chooser 

The Macintosh 512K 
enhanced is preset to print 
documents on an 
ImageWriter™ from the 
Printer port; you can use the 
Chooser to print with other 
printers or from other ports. 

Use the Chooser from the 
Finder rather than fro m 
within applications. If you do 
use the Chooser within an 
application, choose Page 
Setup and confirm the 
settings you want before 
you choose Print. Some 
applications may not let you 
use the Chooser from within 
the application. 
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1. Choose Chooser 
from the Apple menu. 

Make sure you're using at 
least Finder version 5 .1 or 
later and System file version 
3.0 or later on each of your 
startup disks so the Chooser 
will appear in the Apple 
menu . See "Using the 
Installer" in this chapter. 

2. Select the icon that 
represents the type of 
printer you want to use. 

The Chooser always presents 
icons that represent the types 
of printers for which there are 
printing resources on the 
current startup disk. See 
"Using the Installer" in 
this chapter. 

S File Edit Uiew Special 

Select pr in ter port 

user name 
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3. Select additional 
options. 

If you are using an 
ImageWriter, select the icon 
that represents the port the 
printer is attached to. 

If you' re using a LaserWriter, 
select the LaserWriter name 
you 're using. 

If you've installed other 
printing or device resources, 
you may have different 
options, depending on 
what you've installed. 

• Type your name to have the 
Macintosh 51 2Kenhanced 
remember who you are. 

If you're using AppleTalk, 
it must be attached and 
designated as connected in 
the Control Panel. (Choose 
Control Panel from the Apple 
menu .) 



Using the Control 
Panel 

Choose the Control Panel 
from the Apple menu to set 
your personal Macintosh 
preferences and to connect or 
disconnect AppleTalk. See 
"Control Panel" in "Desk 
Accessories" in Chapter 3 for 
more information about the 
Control Panel. 

Make sure you update each of 
your startup disks to have the 
current Control Panel. See 
"Using the Installer" in this 
chapter. 

To set the Desktop 
Pattern 

• Click dots to change them 
from black to white or vice 
versa, or drag through a 
group of dots to change all 
of them. 

• Click the white "menu bar" 
to see a sample pattern. 
(Click on the right side of 
the bar to see the next pattern; 
click on the left side to back 
up. ) 

• Set the pattern by clicking 
the "desktop" below the 
white bar. 

To connect or 
disconnect AppleTalk 

The AppleTalk connection 
setting in the Control Panel 
should always match whether 
you are connected physically 
to AppleTalk or not. Always 
connect or disconnect 
AppleTalk physically first , 
and then immediately 
change the setting in the 
Control Panel to correspond. 

• Click Connected if you' re 
physically connected to 
AppleTalk. 

• Click Disconnected if you 
physica lly disconnect 
AppleTalk. 

To set the Speaker 
Volume 

• Dial the volume you want 
by dragging the knob up or 
down. 

Dialing the lowest volume 
causes the Macintosh 512K 
enhanced to alert you subtly 
by blinking the menu bar 
rather than by beeping. 

s File Edit Uiew Special 
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~ ~~:;:::::ted Jt,, 

7 -

6 -

5 -

4 -

3 

·••· I·••· 
O@O 

Slow Fast 

(j) 0 
Mouse Tablet 

2 -
1 -

0 -

Speaker 
Volume 

RAM l'"32i(l r+l 0 (j) 
Cache L__=.J ~ On Off 

Key Repeat Rate [ I De lay until Repeat 

o o (j) o oll:!·: 11
"
1m?:l!ll o o (j) o o 

Using the Control Panel 53 



54 

To set Your Double­
Click Speed 

• Click the leftmost check 
box for the Macintosh 512K 
enhanced to interpret fairly 
slow successive clicks as a 
double-click. 

• Click the rightmost check 
box to require a faster mouse­
button finger. 

• Click the middle check 
box if you' re somewhere 
in-between. 

To set Mouse Tracking 

• Click the Mouse check box 
if you' re using a mouse. 

You don 't have to move the 
mouse as far as you otherwise 
wou ld when you want to 
jump to another part of the 
screen. 

OR 

• Click the Tablet check box 
if you're using a graphics 
tablet. 

The Tablet setting keeps the 
pointer speed constant. 

~ 0 
Mouse Tab le\ 

To set the Rate of 
Insertion Point Blinking 

• Click any check box from 
Slow to Fast to set the rate 
at which the vertical bar 
marking the insertion point 
blinks. 

:: J;: 
o~o 

Slow Fas\ 
RAM l3zK1 (+I 0 ~ 
Cache ~ l:!:I On Off 

Key Repeat Rate [] Delay until Repeat 

oo~ooll:'\•.:,•,•,w@illll o o~oo 
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To use the RAM Cache 

• Set it On. 

• Use the arrows to scroll to 
the amount of memory you 
want to use for the RAM 
cache. 

Using the RAM cache can 
greatly speed up your work 
with Macintosh. When you 
use the RAM cache, an 
application stores some of the 
information it needs in a part 
of memory you reserve just 
for this- the RAM cache. 
Then, if the application 
needs the information again, 
it doesn 't have to get it from 
the disk, but rather can get it 
much more quickly from the 
RAM cache in memory. 

Of course, using the RAM 
cache does make less 
memory available to 
applications, so you might 
not want to use it (or use a 
smaller amount of it) with 
applications that require 
large amounts of memory. 



To set Key Repeat Rate 

• Click any check box from 
Slow to Fast to set the rate at 
which a pressed key will 
repeat once it starts 
repeating. 

To set Delay until 
Repeat 

• Click any check box from 
Long to Short to set the length 
of time the Macintosh 5 l 2K 
enhanced waits before 
repeating a key you 're 
pressing, or click Off to turn 
off key repeating. 

Delay until Repeat sets the 
length of time the Macintosh 
5 l 2K enhanced waits until it 
starts repeating a key you' re 
pressing. Set a longer delay if 
you 're getting a lot of 
repeated keys when you 
don 't intend them. 

-::: I'::· 
o~o 

Slow Fast 

K•y Repeat Rate [I 
00~00 lli: 

Slow Fast 
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Using the Scrapbook 

You can paste your favorite pictures and text into the Scrapbook 
and retrieve them whenever you want to use them again. For 
example, you might keep your letterheads there. You can cut, 
copy, and paste images among the Scrapbook, your documents, 
or any desk accessory that uses text. 

The contents of the Scrapbook are stored in the Scrapbook file on 
the current startup disk. You can move these Scrapbook files 
among your startup disks to customize the disks with the 
contents you want. See "Copying or Moving a Document, 
Folder, or Application to a Different Disk" in Chapter 2 and 
"Current Startup Disk" in Chapter 3. 

Depending on the size and contents of the image you paste into 
the Scrapbook, you maynotseetheentire image until you paste it 
somewhere else. 

l !H!Prt 
D B I !' ill 

To add an image to the 
Scrapbook 

• With a document or desk 
accessory open, select the 
text or pictures you want to 
add to the Scrapbook. 

See each application 's 
manual for how to select 
using that application. 

• Choose Cut or Copy from 
the Edit menu. 

Choosing Cut removes the 
original; choosing Copy just 
copies it. What you selected is 
placed on the Clipboard, 
where it remains until you 
next choose Cut or Copy. 

Letterhead 

Scrapbook 

• Choose Scrapbook from the 
Apple menu. 

• Choose Paste from the Edit 
menu. 

The image is pasted in front 
of the current image in the 
Scrapbook. The text on the 
bottom left tells you the 
position this image has in the 
Scrapbook. The text on the 
bottom right tells whether 
the image is text or a picture 
and, if it's from a document 
rather than a desk accessory, 
which application the image 
came from. You can use the 
scroll bar to look through the 
Scrapbook. See "Scrolling" 
in this chapter. 

book as a place to keep pictures , 
or anything you create with Macintosh: 

o a 
0 9 
vw • 

rrn ce Ul!JPS :J:: f erhead design to pa ste into your memos 
Hip Hori2on1 d! tribution li st or other frequently used text 
Hip l!erli( o! ary of MacPaint images to i 11 ustrate 
Ho to tP 

See your owner·s guide for more information. 
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To remove an image 
from the Scrapbook 

• Make the Scrapbook open 
and active. 

• Scroll to the image you want 
to remove. 

See "Scrolling" in this 
chapter. Whatever you 
see in the Scrapbook is 
automatically selected when 
the Scrapbook is active. 

• Choose Cut from the Edit 
menu. 

The image is removed from 
the Scrapbook. 

To move or copy an 
image from the 
Scrapbook to a 
document 

• Make the Scrapbook open 
and active. 

• Scroll to the image you want 
to remove. 

See "Scrolling" in this 
chapter. The current image is 
automatically selected. 

• Choose Cut or Copy from 
the Edit menu. 

The image is placed on the 
Clipboard, where it remains 
until you next choose Cut or 
Copy. 

s File Se<!!'( h rormot Font qq!P 

Undo 3€Z Letter to Contractor 

3€H Scrapbook 

1 I a 

Using the Scrapbook 

• If necessary, open the 
document you want to add 
the image to. If the document 
is already open, just click in it 
to make it the active window. 

• Select the place you want 
the image pasted into. 

• Choose Paste from the Edit 
menu. 

The image is pasted into the 
document. 

E. D. Christopt 
Architect 

855 Spruce Dr1' 
Hillsdale, OH 44 

(5 1'3) 555-164 

PICT 
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Using the Finder 
to Manage 
Documents, 
Folders, and 
Applications 

I 
Poge l 

This section summarizes how to use the Finder to manage your documents, 
folders, and applications-how to copy, move, discard, rename, lock, or just 
rearrange them. It also includes a summary of how to manage your documents 
when you 're using an application. It shows you how the folders you create in 
the Finder appear when you 're saving and opening documents within 
applications. 

How you organize your work on the desktop is up to you. You can "nest" 
folders one inside the other to create as many hierarchical levels as you want, 
and you can view the contents of each folder in whatever arrangement gives 
you the information you want to know-by icon, name, date, size, or type. 
Choosing a different view from the View menu instantly rearranges the active 
directory window in the view you choose. For example, you can quickly see 
which document is taking the most space or which is the latest version of a 
report you're preparing. 

The desktop itself is always arranged by icon. 

You can do any of your desktop work with the directories in any arrangement, 
and you can have different directories in different arrangements at the same 
time. Every item in a directory is represented by an icon, no matter what 
arrangement you have the directory in. In any of the text views, the icon is small 
and appears to the left of each name. You can click, double-click, drag, or Shift­
click this icon just as you would its counterpart in an icon view of the directory. 
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Creating a New Document 

You create a new document by opening the application you want 
to use . 

When you' re using an application, you can create more 
documents by choosing New from the File menu. See "Summary 
of Managing Documents Within an Application" in this chapter. 

Special 

3€N 
. I 

Get Info 3€1 • 3€0 

1. Select the icon 
that represents the 
application you 
want to use. 

If necessary, insert the disk 
that contains that application, 
open the disk icon and any 
folders you need to, and 
scroll until you see the 
application icon. 

Paint 
346K m disk 

~ 

2. Choose Open from 
the File menu. 

The appropriate application 
starts, and a new, untitled 
document appears; you'll 
name it the first time you 
save it. 

You can also double-click the 
icon to open it. 

Duplicate 
Put H!l!!Hj IDllllllll Harriet's Garage Sale Roy's Art 
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Opening an Existing Document 

You open an existing document from the Finder by opening the 
icon that represents the document you want to work on. The 
application you'll use with that document starts automatically. 

You can also open an existing document while working in an 
application. Sec "Summary of Managing Documents Within an 
Application '' in this chapter. 

Close 

Get Info 

1. Select the icon 
that represents the 
document you 
want to work on. 

If necessary, insert the 
disk or disks that contain 
that document and 
the application you used to 
create it , open the disk icon 
and any folders you need to, 
and scroll until the document 
icon is visible. 

Paint 
346K in disk 

3€1 
3€D 

MacPaint Harriet's Garage Sale 

0 

2. Choose Open from 
the File menu. 

You can also double-click the 
icon to open it. 

Page Setup 
Print Catalog 

.......... Syslem Folder Brunch Invitat ion Herb's Agenda 

3€[ 
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Using Folders 

Folders let you create a hierarchy of system files , applications, 
and documents so you can arrange your work in whatever way 
you want and get at what you need quickly. 

If you work with just a few applications and a moderate number 
of documents, you might find it easier not to nest many levels of 
fo lders within fo lders. It 's easier to see everything that 's on a disk 
without having lots of folders to rummage through. But if you 
have many documents , and especially if you have a hard disk, 
folders help you get rid of clutter you're not interested in at the 
moment, and they greatly speed up access to what you do want. 

Mac'w'rite 

0 
Sy stem F o ldet" 

To create a new folder 

• Choose New Folder from 
the File menu. 

A folder named "Empty 
Folder" appears in the active 
window. You can rename it 
by typing. 

Memoranda 

~ 
~ 

Note to Lind a 

To place a folder and 
its contents inside 
another folder 

• Drag the folder to the 
fo lder icon or window you 
want it in. 

The fo lder you drag and its 
contents are placed inside the 
folder you drag to. If the 
folder you drag to is on a 
different disk, the folder you 
drag is copied rather than 
moved. 

If the fo lder you drag to 
already contains a fo lder with 
the same name, you'll be 
asked whether you want to 
replace the existing folder. 
Clicking OK replaces the 
existing fo lder and its 
contents with the new folder 
and its contents, whether or 
not the folders ' contents 
include duplicate names. 

Quarterly Reports '86 Quarterly Pr-ojections '87 
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To move a document, 
folder, or application 
from one folder to 
another 

• Drag the item you want to 
move from the folder it's in to 
the folder icon or window 
you want to move it to. 

If the folder you 're moving 
the item to is on a different 
disk, the item is copied, 
rather than moved, to the new 
folder. If the folder already 
contains an item with the 
same name, you 're asked if 
you want to replace the 
existing item. 

To use folders within an 
application 

See "Summary of Managing 
Documents Within an 
Application" in this chapter. 

Special 

Write 
350K in disk 

Correspondence 

Correspondence 
350K in disk 
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Renaming 

You can rename a document, 
folder, application, or disk 
whenever its icon is visible in 
the Finder. 

You can also use the Save As 
command within an 
application to save a 
document with a different 
name. See "Summary of 
Managing Documents Within 
an Application" in this 
chapter. 

64 

1. Select the icon that 
represents what you 
want to rename. 

If necessary, insert the disk 
that contains what you want 
to rename, open the disk icon 
and any folders you need to, 
and scroll until you see the 
icon. 

You need to click explicitly 
on an icon or its name to 
rename it, even if the icon is 
already selected. (This 
prevents your renaming 
something when you didn't 
intend to.) There are a couple 
of exceptions: When you 
create a new folder by 
choosing New Folder from 
the File menu, or when you 
duplicate an item on the same 
disk or copy it to a different 
disk, typing renames 
whatever's selected, without 
your having to click on it. 

~ ~ 
MacPro ject Sample Pro jec1 

If 
MWi+MiffliMI 

System Folder LOB Relocation 

2. Type the new name. 

Use names that wi ll help you 
identify the contents; the 
more specific the name, the 
better. Document and folder 
names can be up to 31 
characters long (though a 
name that long would be a 
little unwieldy when you 
drag its icon around), and 
disk names can be up to 27 
characters. You can use any 
character you can type on the 
keyboard , except a colon(:). 
You can use uppercase or 
lowercase letters and put 
spaces between words. 

The selected text (the old 
name) is replaced by the new 
text you type. 

MacProject Sample Project 

• ilil 
George's Edited 0. Gj 

System Folder LDB Relocation 
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3. Or use the Edit menu 
to edit the text. 

See "Editing Text" in this 
chapter. 

Write the name of the disk on 
the disk label. That way, when 
the Macintosh 512K 
enhanced asks you to insert a 
specific disk, you'll know 
which one it needs. Also, 
write the names of the disk's 
documents on its label. 



Copying a 
Document, Folder, 
or Application to 
the Same Disk 

You can use the Finder to 
copy a document, folder, or 
application whenever you 
can see its icon. You might do 
this to make a backup copy. 
(See also "Copying an Entire 
Disk" in this chapter.) Or you 
might want to make a copy 
of a document to work on 
without al tering the original. 
For example, you might 
do this to create forms , 
letterheads, or templates. 

To make a copyofa document 
while using an application, 
see "Summary of Managing 
Documents Within an 
Application'' in this chapter. 

1. Select the icon 
that represents the 
document, folder, 
or application you want 
to copy. 

If necessary, insert the disk or 
disks that contain what you 
want to copy, open the disk 
icon and any folders you 
need to, and scroll until 
you see the icon. 

See "Selecting Icons" in this 
chapter for how to select 
more than one icon to 
duplicate. 

2. Choose Duplicate 
from the File menu. 

A new icon appears. The 
duplicate icon has the same 
name as the original, 
preceded by the words 
"Copy of". 

You can drag the duplicate 
copy to any folder or disk 
icon or window. 

The directory of the 
destination disk or folder can 
be arranged in an) \ iC\\ 
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3. Rename the 
duplicate. 

You can rename any 
duplicate copy of a document 
or folder by typing 
immediately after you create 
the copy. Any other time, 
you must click the icon that 
represents what you ' re 
renaming before you type the 
new name. See "Renaming" 
in this chapter. 
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Copying or Moving a Document, Folder, 
or Application to a Different Disk 

You can copy a document, folder, or application to another disk 
whenever both disk icons-the one that holds the source and the 
one that represents the destination-are present. The source 
disk must be opened into a directory window, so you can select 
the document , fo lder, or application you wa nt to copy; the 
destination disk can be either in icon fo rm or opened into a 
directory window. 

1. If necessary, insert 
the disk you want to 
copy to, so its icon will 
be present. 
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2. If necessary, insert 
the disk that contains 
what you want to copy. 

If you're using a one-drive 
system, eject the disk you're 
copying to before you insert 
the disk you' re copying from. 



3. If necessary, open the 
disk icon and any 
folders you need to and 
scroll until you see the 
icon that represents 
what you want to copy. 

4. Drag what you want 
to copy to the place you 
want to copy it. 

You can drag it either to a disk 
or folder directory window, 
or to an icon that represents 
the disk or folder you want it 
to be in. 

If you drag to a directory 
window, you can place the 
icon wherever you want; if 
you drag to an icon, the Finder 
places the item in the next 
available spot. You can also 
drag to the hollow icon that 
remains behind when you 
open an icon. 

See "Selecting Icons" in this 
chapter for how to select 
more than one icon to copy. 

If you 're using a one-drive 
system, the Macintosh 512K 
enhanced wi ll present a 
series of dialog boxes, asking 
you to insert alternately the 
disk you 're copying from and 
the disk you're copying to. 

If the destination disk already 
contains an item with the 
same name, you 'll be asked 
to confirm that you want to 
replace the current contents 
with what you're copying. 

What you copied appears in 
the window you dragged to. 
(If you dragged to a disk or 
folder icon, what you copied 
will appear in the directory 
window when you open the 
icon .) 
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5. If you're moving 
rather than copying, 
drag the original to the 
Trash. 

Whenever you drag from one 
disk to another, a copy of 
what you move is left behind 
for safekeeping. If you want 
to reclaim the space on the 
original disk, you can drag 
the remaining icon to the 
Trash. 
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Removing or Recovering a Document, 
Folder, or Application 

You can discard a document, fo lder, or application whenever its 
icon is visible. The Trash can be visible as an icon or opened into 
a directory window. 

What you discard can usually be recovered until you empty the 
Trash, start an application, or eject the disk. You can recover a 
removed document, fo lder, or application if you can see its icon 
in the Trash window. 

To remove a document, 
folder, or application 

• If necessary, first open the 
window that contains what 
you want to remove, and 
scroll until you see the icon or 
icons. 

• Drag the icon or icons that 
represent what you want to 
remove to the Trash icon or 
window. 

See "Selecting Icons" in this 
chapter for how to select 
more than one icon to discard. 
Discard an entire disk by 
choosing Select All from the 
Edit menu. 

To reclaim the space 
immediately, choose Empty 
Trash from the Special menu . 

~ 
~ 

Final Draft 

II 
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I 
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To recover a removed 
document, folder, or 
application 

You can recover an item as 
long as its icon is visible in the 
Trash window. 

• If necessary, open the Trash 
window and scroll until you 
can see the icon that 
represents what you want 
to recover. 

• Drag the icon out of the 
Trash window onto the 
desktop or into another 
window. 

See "Selecting Icons" in this 
chapter for how to select 
more than one icon to 
recover. 

If you can't remember where 
items in the Trash came from, 
you can select what you want 
to recover and choose Put 
Away from the File menu. 



Locking a 
Document or 
Application 

Locking a document or 
application prevents it from 
being renamed or discarded. 
Locking a document also 
prevents saving any changes 
to it. You can, however, open 
and print locked documents. 

See "Disks" in Chapter 3 for 
how to lock disks physically. 

1. Select the icon 
that represents 
the document or 
application you want 
to lock. 

2. Choose Get Info from 
the File menu. 
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Locking a Document or Application 

3. Click Locked. 

The Locked box is checked. 
You unlock a locked 
document or appl ication by 
clicking the checked box. 

Directories in text views 
indicate which of your 
documents and applications 
are locked by displaying a 
small padlock on the right. 
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Printing 

In the Finder you can print 
a document, a group of 
documents, the contents 
of the entire screen, the 
contents of the active 
window, or a disk or folder 
directory. You can also create 
a MacPaint document from 
the contents of the screen for 
later printing. You can print a 
document whenever its icon 
is visible and a disk that 
contains its application is 
currently inserted. When you 
print from the Finder, the 
document 's application is 
opened automaticall y. 

To print a document while 
using an application, see 
"Summary of Managing 
Documents Within an 
Application" in this chapter. 

If you're using an 
Image Writer, make sure that 
the printer is ready, the select 
light is on, and the paper is at 
the top of a form. 

If you 're using a printer other 
than the ImageWriter, if you 
have more than one printer, 
or if your printer is attached 
somewhere other than the 
Printer port, use the Chooser 
desk accessory to te ll the 
Macintosh 512K enhanced 
which printer to use. See 
"Using the Chooser" in this 
chapter. 
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To print a document 

• Select the icon that 
represents the document 
you want to print. 

If necessary, insert the disk 
or disks that contain the 
document and the 
application you used to 
create it, open the disk icon 
and any fo lders you need to, 
and scroll until you see the 
document icon. 

• Choose Print from the File 
menu. 

One or more dialog boxes 
may appear, with options for 
printing your document. 

To print a group of 
documents 

• Select the docu ment icons. 

See "Selecting Icons" in this 
chapter for how to select 
more than one document to 
print. 

If necessary, insert the disk 
or disks that contain those 
documents and the 
application you used to 
create them, open the disk 
icons and any folders you 
need to, and scroll until you 
see the document icons. 

• Choose Print from the File 
menu. 
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To create a MacPaint 
document with the 
current contents of 
the screen 

• Hold down both the 
Command and Shift keys 
whiie you type the number 3. 

If you' re also pressing the 
mouse button, the action will 
start when you release the 
button. 

1~ 
Command key 

You can take up to 10 
"snapshots" on the current 
startup disk. Each snapshot 
appears in the disk directory 
window, named sequentially 
from Screen 0 to Screen 9. 
You can open and make 
changes to these documents 
as you do to any existing 
document. See "Opening an 
Existing Document" in this 
chapter. A beep means the 
snapshot wasn't successful ; 
perhaps the disk is fu ll , or 
there are already snapshots 
with those numbers on that 
disk. 



To print the current 
contents of the entire 
screen 

• With Caps Lock down, hold 
down both the Command 
and Shift keys while you type 
the number 4. 

If you ' re also pressing the 
mouse button, the action will 
start when you release the 
button. 

You can 't use this method 
with a LaserWriter. 

To print the current 
contents of the active 
window 

• Hold down both the 
Command and Shift keys 
while you type the number 4. 

If you 're also pressing the 
mouse button, the action will 
start when you release the 
button. 

You can't use this method 
with a LaserWriter. 

To print a disk or folder 
directory 

• In the Finder, make the 
directory window active. 

• Choose Page Setup from 
the File menu to set paper 
size , printing orientation, 
and other options. 

• Choose Print Catalog from 
the File menu and select 
printing options in the dialog 
box that fo llows. 

• Select printing options 
from the choices that appear 
in the dialog box and click 
OK or press the Return key. 

The directory is printed in 
whatever view you have it 
arranged. 



Using the MiniFinder 

The MiniFinder lets you move among documents and 
applications faster than you can by returning to the Finder each 
time you want to work with a different application. You might 
want to install the documents and applications you use most 
often in the MiniFinder. 

You can install the MiniFinder on any of your disks that contain 
applications, whether or not they're startup disks. The Macintosh 
512K enhanced always starts up with, and applications quit to, 
any MiniFinder on the current startup disk. 

To install what you want 
to get at quickly in the 
Minifinder 

• In the Finder, select what 
you want to place in the 
Mini Finder. 

See "Selecting Icons" in this 
chapter. 

You can select up to 12 mixed 
or matched documents and 
applications. The documents 
and applications you select 
must be in the same directory 
window; drag them there if 
necessary. Any applications 
you need to work on 
documents in the MiniFinder 
must be on the same disk, but 
they don't need to be in the 
MiniFinder. If you move an 
application to a different 
fo lder after you've installed 
the MiniFinder, however, the 
Mini Finder won't be able to 
find it. 

• Choose Use MiniFinder 
from the Special menu. 

If the command is dimmed, 
check to see if the disk is 
locked. 

• Click Install. 

A MiniFinder icon is placed 
in the System Folder. 

The next time you start your 
Macintosh 5 l 2K enhanced 
using this disk, or quit an 
application on this disk, the 
MiniFinder will appear 
instead of the usual desktop. 

Applications Disk 
12 items 

c 
Systl!'m 

+ I . 

4771<' in disk 323K available 

Install the MiniFinder using the 
selected documents or applications, or 
remoue the MiniFinder. 

( Cancel ) 
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To use the MiniFinder 

• Open an application or 
document in the MiniFinder 
by selecting it and clicking 
Open or by double-clicking 
its icon. 

• Return to the Finder by 
clicking Finder or pressing 
the Enter key. 

Click the Drive button or 
press the Tab key first , if 
necessary. 

• Open other applications on 
the same or different disks by 
clicking Open Other. 

A dialog box appears. It's the 
same dialog box you see 
when you choose Open 
within an application, but in 
the MiniFinder you see and 
open applications rather than 
documents. See "Summary 
of Managing Documents 
Within an Application," 
which follows. 

• Eject any inserted disks and 
restart the Macintosh 512 K 
enhanced by clicking Shut 
Down. 

• See MiniFinders installed 
on other disks by using the 
Eject and Drive buttons. 

To change what 
applications and 
documents are in 
the MiniFinder 

• In the MiniFinder, click 
Finder. 

Use the Drive button first if 
necessary. 

• In the Finder, select what 
you want to place in the 
Mini Finder. 

See "Selecting Icons" in this 
chapter. 

You can select up to a total of 
12 mixed or matched 
documents and applications. 

~ 

The documents and 
applications you select must 
be in the same directory 
window. Drag them there if 
necessary. Any applications 
you need to work on 
documents in the MiniFinder 
must be on the same disk, but 
they don 't need to be in the 
MiniFinder. If you move an 
application to a different 
folder after you 've installed 
the MiniFinder, the 
MiniFinder won't be able 
to find it. 

• Choose Use MiniFinder 
from the Special menu. 

• Click Install. 

I I 
MacWrite Letter to Ma... Proposal 9/3 

~ [Q 
MacPaint Letterhead 

Using the MiniFinder 

To remove the 
MiniFinder 

• In the MiniFinder, click 
Finder. 

Use the Drive button first if 
necessary. 

• Choose Use MiniFinder 
from the Special menu. 

• Click Remove. 

Dragging the MiniFinder 
icon to the Trash also 
removes the Mini Finder. 

Eject 

Driue 

Shut Down 
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Summary of 
Managing 
Documents Within 
an Application 

You can do quite a lot of 
document management 
without leaving an 
application you' re using. 
You can open documents, 
close them, save them, and 
print them. And you can 
organize your work using the 
same fo lders you create in the 
Finder. 

If you don't see fo lders you 
created in the Finder when 
you choose Open or Save As 
within an application, you 
probably haven't updated the 
current startup disk, or the 
disk you 're looking at isn 't 
initialized two-sided. See 
"Using the Installer" and 
"Initializing Disks" in this 
chapter. 

Current disk -------

To create a new 
document 

• If necessary, save any 
unsaved changes and then 
choose Close from the File 
menu to close the current 
document. 

With some applications, you 
can have just one document 
open at a time. 

• Choose New from the 
application 's File menu. 

A new document appears; 
you'll name it the first time 
you save it. 

To open an existing 
document 

• If necessary, save any 
unsaved changes and then 
choose Close from the File 
menu to close the current 
document. 

With some applications you 
can have just one document 
open at a time. 

• Choose Open from the 
application 's File menu . 

A dialog box appears, with a 
directory of the current folder 
or disk. The directory name 
(and a folder or disk icon) is 
above the alphabetized list of 
the directory's contents; the 
name of the current disk (and 
a disk icon) appears to the 
right. 

• I "I 

D System Folder 
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The folders in this dialog box 
correspond to the fo lders you 
create in the Finder. And you 
open them in the same way 
you open folders in the 
Finder, by selecting them 
and choosing Open, or by 
double-clicking them. 

Within applications, folders 
show only the documents the 
current application can open, 
even if the corresponding 
folders in the Finder contain 
other documents or 
applications. 



• To see che concents of 
a folder in the current 
directory, select its name and 
click Open, or just double­
click its name. 

You see the contents (both 
folders and documents) of 
the folder you open. You can 
move down through the 
entire hierarchy of folders in 
this same way, opening 
folders within the currently 
open folder, until you reach 
the document you want to 
open. 

• To move back up the 
hierarchy of folders , press the 
directory name and choose 
the folder or disk directory 
you want. 

A pull -down list appears 
below the directory name 
when you press the name 
or anywhere in the bar that 
contains the name. Each 
folder in the hierarchy is in 
the list, and the disk directory 
(which includes anything on 
the disk that's on the desktop 
or not in any folder) is at the 
end of the list. 

D LDB Relocation 
D Operations Relocation 

• To see documents and 
fo lders on other disks , use the 
Drive and Eject buttons. 

Clicking Drive (or pressing 
the Tab key) always brings 
you to the top level of any disk 
inserted in a second drive. 

• Open the document you 
want to work on by clicking 
its name and then clicking 
Open or by double-clicking 
its name. 

To quickly select a document 
or folder in the current 
directory, type the character 
or characters you want te find 
and select. If you pause while 
typing, the next character you 
type is considered a new 
request rather than a 
continuation of the old. The 
Delay Until Repeat setting in 
the Control Panel controls 
how long the pause can be 
before subsequent typing 
begins a new request. 

You can also use the direction 
keys to move up and down the 
list of names. 

If the disk you 're looking at 
has been initialized one­
sided, the disk directory that 
appears shows no folders, 
only documents. 

You always enter the 
hierarchy of documents and 
fo lders at the place you last 
opened a document from or 
saved a document to. 
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To save a document 

A document is stored only 
temporarily until you save it 
on a disk. 

• Choose Save from the 
application's File menu. 

Use the Save rather than the 
Save As command for 
routine, periodic saving of 
your document. The Save 
command saves a document 
with its original name on the 
same disk. Choose Save As 
when you want to save the 
current document with a 
different name, or to copy it 
to a different folder or disk. 

• If this is a new document 
that hasn 't yet been saved, 
you see the same dialog box 
that appears when you 
choose the Save As 
command. See "To save a 
document with a different 
name, or in a different folder, 
or on a different disk" in the 
next column. 

To save a document 
with a different name, 
or in a different folder, 
or on a different disk 

Whenever you want to save 
a document with a different 
name, or save it in a different 
folder or on another disk, you 
use the Save As command. 

• Choose Save As from the 
application 's File menu. 

A dialog box appears, with 
a directory of the folders 
contained in the current 
folder or disk. The directory 
name (and a folder or disk 
icon) is above the 
alphabetized list of the 
folders it contains; the name 
of the current disk (and a disk 
icon) appears to the right. 

The folders in this dialog box 
correspond to the folders you 
create in the Finder. 

• To see the folders inside 
a folder in the directory, 
double-click the fo lder's 
name. 

You see any folders within the 
fo lder you opened. You can 
move down through the 
entire hierarchy of folders 
in this same way, opening 
folders within the currently 
open folder, until you open 
the folder you want to save 
your document in. 

\'{11en you' re saving rather 
than opening documents, you 
see the entire contents of the 
folder. All items except 
folders appear dimmed. 

• To move back up the 
hierarchy of folders, press the 
directory name and choose 
the folder or disk directory 
you want. 

A pull-down list appears 
below the directory name 
when you press the name or 
anywhere in the bar that 
contains the name. Each 
fo lder in the hierarchy is in 
the list, and the disk directory 
(which includes any folder 
on the disk that's on the 
desktop or not in any other 
folder) is atthe end of the list. 
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• To see folders on other 
disks, use the Drive and Eject 
buttons. 

Clicking Drive or pressing 
the Tab key always brings you 
to the top level of any disk 
inserted in a second drive. 

• Type a new name for the 
document if it's a new 
document or if you want to 
change the current name; 
otherwise it will be saved 
with the same name . 

You can use any character or 
symbol on the keyboard 
except a colon(:). You can 
use uppercase or lowercase 
letters and put spaces 
between words. Names can 
be any length up to 31 
characters, but long names 
can become unwieldy. It 's 
usually best to limit them to 
the space you have to type 
them in. 

• To save the current 
document in the fo lder 
named at the top of the list, 
click Save. 

If the disk you re looking at 
has been initialized one­
sided, the disk directory that 
appears shows no folders. 
only a blank disk directory 
The document will he saved 
at the disk level of the 
hierarchy. without being 
placed in a folder. 

You always enter the 
hierarchy of documents and 
folders at the place you last 
opened a document from or 
saved a document to. 

Even though more than one 
document on a disk can have 
the same name as long as 
they're in separate fo lders, it 
may be easier to keep track of 
documents if you give each 
version a different name. 

To print a document 

If you 're using a printer other 
than an Image Writer, if you 
have more than one printer, 
or if your printer is attached 
somewhere other than the 
Printer port, use the Chooser 
desk accessory to tell the 
Macintosh 5 l 2K enhanced 
which printer to use . Some 
applications may not let you 
use the Chooser; choose Quit 
and use the Chooser in the 
Finder. And with most 
applications, it 's generally 
better to use the Chooser in 
the Finder rather than within 
the application. See "Using 
the Chooser" in this chapter. 

• Choose Page Setup to set 
printing options such as page 
orientation and paper size. 

• Choose Print from the File 
menu. 

Chart Task Layout Dates Fonts Style In most applications, one or 
more dialog boxes appears . 
You can click the various 
options to control the way 
your printed document will 
look. See "Printing" in this 
chapter for information about 
printing from the Finder. 

untitled 
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will be Saved in 
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Managing Disks You'll use the Finder to manage enti re disks as well as the documents, folders, 
and applications on them. Renaming disks works the same as renaming any 
icon. See "Renaming" in this chapter. 

Chapter 3, "Reference," contains additional information about disks . 

• 

Managing Disks 79 



Initializing Disks 

Whenever the Macintosh 512K enhanced encounters a disk it 
can't interpret, a dialog box appears and asks whether you'd like 
to initialize the disk. With the Macintosh 512K enhanced SOOK 
disk drive, you have three choices-to initialize the disk with 
either a one-sided or two-sided format, or to eject without 
initializing. 

In general, initialize single-sided ( 400K) disks (they're beige 
in color) one-sided, and double-sided (SOOK) disks (they're 
white) two-sided. Disks that are initialized one-sided don' t show 
any folders when you use directories within applications 
(whenever you choose Open or Save As from the application's 
File menu). To use folders within applications, you need both a 
double-sided disk initialized two-sided and a startup disk with 
Macintosh 512K enhanced software. 

Even when you initialize a disk rwo-sided. you always insert disks 
in the same way, metal end first. label side up. The disk drive is 
able to get information from both sides of the disk. 

If the uninitialized disk is in an external "t00K disk drive. you 're 
offered just two choices-initialize the disk (one-sided) or eject. 

In the Finder you can also initialize disks that have information 
on them by choosing Erase Disk from the Special menu. This 
erases everything on the disk and gives you the same 
initialization choices you get with a new disk. 

You can initialize disks from within an application without losing 
any information in memory, so you can in itialize them as you 
need them. 

LJ This disk is unreadable: 

LJ Do you want to initialize it? 

[ Eject J [One-Sided J li:Y,fftitfil 

To initialize both sides 
of a double-sided disk 

• Insert a double-sided 
(SOOK) disk you want to 
initialize. 

• Click Two-Sided. 

• If necessary, type a name 
for the disk. 

To amid confusion. be sure to 
give disks different names. 

This installs the hierarchical 
file system that lets you use 
fo lders within an application 
as well as in the Finder. 
Whenever you choose Open 
or Save As or save an untitled 
document while you 're in an 
application, you'll see and be 
able to use the same folders 
you use in the Finder. See 
"Using Folders" and 
''Summary of Managing 
Documents Within an 
Application" in this chapter. 

Once you 've initialized a disk 
with the two-sided format, 
you can't use it in a 400K disk 
drive because the 400K disk 
drive won't be able to read it. 
You'll be asked if you want to 
initialize the disk, and 
clicking In itialize wi ll erase 
everything on the disk. 

Never initialize a single-sided 
disk with the two-sided 
format. The second side of the 
disk has not been tested for 
reliability. and you could lose 
all the information on the 
disk. 
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To initialize a disk so 
you can use it in a 400K 
disk drive 

• Insert the disk you want to 
initialize. 

• Click One-Sided. 

• If necessary, type a name 
for the disk. 

To avoid confusion, be sure to 
give disks different names. 

You can initialize an SOOK 
disk one-sided. This wi ll let 
you use this disk in a 400K 
disk drive; however, it makes 
only half the disk space 
available to you and it doesn't 
install the hierarchical file 
system, so you won 't be able 
to use folders within 
applications on this disk. 



Ejecting a Disk 

To get information from or save information on a disk not 
currently inserted, you sometimes first need to eject a currently 
inserted disk. 

If the Macintosh 512K enhanced needs the ejected disk later, 
it will ask for it. 

Ejecting a Disk 

1. Select the icon that 
represents the disk you 
want to eject. 

Or you can make the disk 
directory window active if 
you've opened the icon. 

2. Choose Eject from 
the File menu. 

Or hold clown the Command 
key and type the letter "e" . 

[ 3€ 

Command key 

Dragging a disk icon to the 
Trash both ejects the disk and 
removes the icon from the 
desktop. (The Macintosh 
512Kenhanced won't ask for 
it again.) If you drag the 
current startup disk to the 
Trash, the Macintosh 512K 
enhanced ejects the disk but 
doesn 't remove its icon. 

Choosing Eject usually ejects 
a disk (if one's inserted and 
it's not a hard disk), even if 
none is selected. The Finder 
looks for an inserted disk to 
eject. 

Choosing Shut Down from 
the Special menu also ejects 
any inserted 3 Yi-inch disks 
and restarts the Macintosh 
512K enhanced. 
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Creating a Startup 
Disk 

The Macintosh 512K 
enhanced needs certain 
info rmation to be able to start 
up the system. Disks that 
contain this information (in 
system fi les such as System 
and Finder in the System 
Folder) are called startup 
disks. Since this info rmation 
can take a fair amount of 
room on a disk, you probably 
won't want to have all your 
disks be startup disks , 
especially if you're using 
more than one disk drive. You 
do need to use a startup disk 
each time you start your 
Macintosh 512 K enhanced. 

In the Finder, the current 
startup disk's icon appears 
in the top right corner of 
the desktop. 

See "Startup Disks" in 
Chapter 3. 
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1. Insert the Macintosh 
512K enhanced System 
Too/sdisk. 

You can also use any startup 
disk that has Macintosh 512 K 
enhanced system files on it­
inclucling Finder version 5.1 
or later and System file 
version 3.0 or later . You can 
check a startup disk's Finder 
version by starting up with 
that disk and choosing About 
the Finder from the Apple 
menu. Check a System fi le's 
version number by selecting 
the System file in the System 
Folder and choosing Get Info 
from the File menu. 

If you're using a one-drive 
system, eject this disk before 
going on to the next step, by 
choosing Eject from the File 
menu. 

2. Insert a new double­
sided (BOOK) disk, click 
the two-sided option, 
and name the disk. 

See "Initializing Disks" in 
this chapter. 

System Tools 

423K in disk 
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3. Drag the System 
Folder to the new disk 
icon. 

You can acid any applications 
you want on the startup disk. 
See "Copying or Moving 
a Document, Folder, or 
Application to a Different 
Disk" in this chapter. 

To turn a startup disk into a 
non-startup disk (a disk just 
for storing documents): start 
the system using any disk 
other than the one you want 
to be a non-startup disk. 
Insert the disk you want to 
change to a non-startup disk. 
Drag the System Folder to the 
Trash. 



Copying an Entire 
Disk 

You can copy an entire disk 
whenever you can see both its 
icon (the source disk icon) 
and the icon of the disk you 
want to copy to (the 
destination disk icon ). 

Give each disk a unique, 
meaningful name (either 
when you're asked to name 
a new disk or after you finish 
the copying process). If each 
disk has its own name, it will 
be easier to keep track of your 
documents, and you 'll know 
which disk to insert when the 
Macintosh 512K enhanced 
asks you for a specific disk. 
See "Names ofDisks and 
Documents" in "Disks" in 
Chapter 3 

1. Insert both the 
source disk and the 
destination disk. 

If necessary, first eject any 
other disk by selecting its 
icon and choosing Eject from 
the File menu . If you're using 
a one-drive system, insert 
and eject the destination disk, 
and then insert the source 
disk. 

Start your Macintosh 51 2 K 
enhanced using a disk other 
than the one whose contents 
you want to replace; you can't 
replace the contents of the 
current startup disk. 

If the destination disk is a new 
disk, you' II be asked if you 
want to initialize it. See 
"Initializing Disks" in this 
chapter. 

Copying an Entire Disk 

2. Drag the source disk 
icon to the destination 
disk icon. 

You'll be asked to confirm 
that you want to replace the 
existing contents of the 
destination disk with the 
contents of the source disk. 

The Macintosh 51 2K 
enhanced will tell you if 
there's not enough room on 
the destination disk- if 
you're trying to copy a full 
SOOK disk to a 400K disk, for 
example. 

If you're dragging to a hard 
disk, the contents of the hard 
disk aren't replaced. Rather, 
the contents of the disk you 
drag to it are added to the 
hard disk. 
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Using the Font/DA 
Mover 

As new fonts and desk 
accessories become 
available, you may want to 
add some of them to your 
startup disks so you can use 
them whenever you use an 
application with those 
disks. But fonts and desk 
accessories can take up a fair 
amount of space on a disk, so 
you probably won' t want a 
complete set on every startup 
disk. The Font/DA Mover 
(Font and Desk Accessory 
Mover) is an application for 
copying fonts and desk 
accessories among disks or 
removing them from disks. 

The Apple and Font menus 
for any application always 
contain the fonts and desk 
accesories that are in the 
current startup disk 's System 
file (a fi le in the System 
Folder). You can also store 
collections of fonts and desk 
accesories in special font and 
desk accessory files the 
Macintosh 512K enhanced 
uses just for that purpose. The 
System Tools disk includes 
two desk accessories-the 
Note Pad and the Puzzle-in 
an accessory file and special 
fonts in a fonts file you may 
want to add to some of your 
startup disks. 
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1. Select the Font/DA 
Mover icon and choose 
Open from the File 
menu, or just double­
click the icon. 

The Font/DA Mover is 
included on the System Tools 
disk. You can open it there or 
copy it to any other disk. 
See "Copying or Moving a 
Document, Folder, or 
Application to a Different 
Disk" in this chapter. 

You can also open any font or 
desk accessory file to open 
the Font/ DA Mover 
automaticall y. 

A desk accessory fi le 

A font fil e 

@Font 

2. Click either the Font 
or the Desk Accessory 
button, depending on 
what you want to add or 
remove. 

The list on the left includes all 
fonts or desk accessories in 
the System file on the current 
startup disk , whether the disk 
is in the internal or external 
disk drive. (If you open a fom 
or desk accessory file instead 
of Font/ DA Mover, the list on 
the left shows the contents of 
that fil e ) 

O Desk Ac:c:essory Mouer 

Chicago 12 
Courier 1 O 
Courier 12 
Geneua 9 
Geneua 1 O 
Geneua 12 
Geneua 14 

System 
on System Tools 

365K free 

Close 

\QI [ r opq 

Wfil [ HP!110!JP 

~ 
Help 

Quit Open ... J 
......... ....... .. ···· · ··~······ 
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3. Use the Open buttons 
to present lists of any 
other System, font, or 
desk accessory files on 
any inserted disk. 

If necessary, first cl ick Close 
to close the file currently 
displayed. Each Open button 
lets you control what's 
displayed in its list. Both the 
fi le you're looking at and the 
disk it's on are shown below 
each list. 

Whenever you click an Open 
button, a dialog box appears 
with a directory of fo lders and 
documents on the current 
disk or in the current folder. 
See "Summary of Managing 
Documents Within an 
Application" in this chapter. 

Use the Eject or Drive buttons 
to look at font or desk 
accessory files on other disks. 
The name of the disk you' re 
looking at is always shown at 
the top right. 



4. Open the file you 
want to look at by 
selecting its name and 
then clicking Open or 
by double-clicking its 
name. 

You can look at and work with 
any existing System, font, or 
desk accessory fi les. The 
Fonts and desk accessory fil es 
on the System Tools disk 
contain fo nts and desk 
accessories you may want to 
acid to some of your startup 
disks. 

• If you'd like, create a new 
file for your own collection of 
fonts or accessories by 
click ing New, naming the 
file, and clicking Create. 

5. Select the fonts or 6. Click Copy to copy 7. Click Quit. 
desk accessories you the selected fonts or 
want to copy or remove. accessories in the 

direction the arrows 
point, or click Remove 
to remove them. 

You can select from either Clicking Copy copies the In the Finder, you can drag 
list. Click to select a single fonts or desk accessories to any font or accessory files you 
font or accessory, hold clown the opposite fil e; clicking no longer need to the Trash, 
the Shift key while you click Remove removes them from or copy or move these fil es 
additional single fonts or the fi le they're in . If a font or between disks. See "Copying 
accessories, or drag to se lect a accessory with the same or Moving a Document, 
group. Shift -click to deselect name as one you se lected Folder, or Application to a 
a selected file. The number already ex ists in the opposite Different Disk" in this 
of bytes selected is displayed list, it will be replaced by the chapter. Opening any font or 
as well as the amount of space selected font or accessory. accessory file automatically 
available on the disk. Both If you remove all fonts or opens the Font/ DA Mover. 
the name of the current fi le accessories from a font or 
and the name of the disk it 's accessory file, the fi le itself You can use the Font/ DA 

on are displayed below each will be gone the next time Mover to create an auxiliary 

list. you click Open. You can't set of fonts or accessories. 

remove certain fonts the Later you can move the 
When a single font is System needs. current System fi le fonts or 
selected, the name, size, accessories to another font or 
and a sample of the font are On ly fonts and desk accessory fil e you create, and 
shown at the bottom of the accessories in the current then copy the auxiliary file to 
window; when more than startup disk's System fi le are your System fil e. You can use 
one font is selected or when ava ilable to applications you the Font/ DA Mover to 
a desk accessory is selected, use with that disk. You're alternate between the two 
nothing is displayed. limited to 15 desk accessories fi les (or any others you 

in a System fi le. create) whenever you want. 

@Font Mouer 
O Desk Accessory 

Chicago 12 
Courier 1 O 
Courier 12 
Geneua 9 
Geneua 1 O 
Geneua 12 
Geneua 14 

IQ: « Copy <3:J Los Angeles 24 lQ 

Romo"~ ) ~.l:~JT~~"" I 8 I 
System 

on System Tools 
365K free 

Close 

Mobile 18: 

Using the Font/DA Mover 

8074 bytes Symbol 9 
selected Symbol 12 Hl 

Help 

Quit 

Fonts 
on System Tools 

365K free 

Close 
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Using the Installer 

Applications you purchase may not always include the latest 
system files on their startup disks. (See "Startup Disks" in 
Chapter 3.) Each startup disk you use with your Macintosh 512K 
enhanced shou ld have the latest system files avai lable-at least 
Finder 5.1 or later and System file 3.0 or later. You can check the 
Finder version number on a startup disk by starting up with the 
disk and choosing About the Finder from the Apple menu. 
You can check the System file version number by selecting the 
System icon in the System Folder and choosing Get Info from the 
File menu. 

With a startup disk that's not updated, folders and all their 
contents may not appear when you choose Open or Save As 
within an application, or folders may appear empty within the 
Finder. If this happens, just update the startup disk; your 
"missing" folders and their contents wi ll reappear. Also, if you 
don't update , characters you type on the keyboard may produce 
the wrong results in certain applications. 

There are three ways to update to Macintosh system software: 

D Create a new startup disk by copying Macintosh system files to 
a new, double-sided disk. This lets you start from scratch, re­
creating each of your application disks with twice as much 
space and Macintosh 512K enhanced system features. See 
"Creating a Startup Disk" in this chapter. 

D Copy Macintosh system fil es to an existing startup disk. 
This replaces the existing System file and Finder. The startup 
disk remains in whatever format it was-one- or two-sided. 

D Use the Installer to modify an existing startup disk. This 
updates the System file whi le keeping any customization 
it has , such as fonts , accessories, or hard disk resources. 
The Installer also updates the Finder to version 5.1 or later 
and updates any printing resources on the disk. 

Using the Installer is necessary when you 're using a copy­
protected application on the startup disk or an application or a 
hard disk requires a specially modified System file. (With the 
Hard Disk 20 TM you can either use the Installer or drag system 
files.) 

Other Installer options add or update printing resources for the 
ImageWriter, LaserWriter, or AppleTalk ImageWriter. You need 
a corresponding printing resource for each printer you use with a 
startup disk. 

1. Start the Macintosh 
512K enhanced using 
the disk that contains 
the Installer. 

You can 't replace the system 
files on the current startup 
disk. 

The Installer is in the Utilities 
Folder on the System Tools 
disk. Use it there or copy the 
Installer, the System Folder, 
the Font/ DA Mover, and 
Installer Scripts folder to 
another disk. 
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2. Open the Installer. 

Either select the icon and 
choose Open from the File 
menu or just double-click the 
icon. 

Get Info 
Duplicate 
Put Humq 

Page Setup 
Print Catalog 

:l€£ 



3. Insert the startup 
disk you want to 
update. 

If you have a one-drive 
System, first eject the disk 
that contains the Installer. 

The Installer wi ll update the 
disk named at the top right. 

4. Click Macintosh 
512K enhanced and 
any other printing 
resources you want. 

Installing Macintosh 512K 
enhanced automatically 
updates any existing printing 
resources on the disk. You 
can also select any printing 
resources you want to add. 

You can use the Font/DA 
Mover to customize the disk 
with the fonts and desk 
accessories you want to use 
with it. See "Using the 
Font/ DA Mover" in this 
chapter. 

Disk to be updated 

Installer 

RppleTillk lmageWriter (u 2.1) 
I mageWriter (u 2.1) 
LaserWriter (u I. I) 
Macintosh 512K enhanced (u 1.0) ~ 

Using the Installer 

5. Click Install to install 
what you selected. 

You can also click Remove to 
remove what 's selected. 

A Note About Hard Disk 2 0: 

If you purchase a new Hard 
Disk 20, once you connect it 
to your Macintosh 512 K 
enhanced and start up with 
an updated startup disk, 
you'll be asked if you want to 
initialize the hard disk. Once 
you've clone this, make the 
Hard Disk 20 a startup disk by 
dragging the System Folder 
from the System Tools disk to 
the hard disk. You won 't need 
the HD 20 Startup disk at all. 

Project 

Eject 

Oriti!~ J 

lns1<111 ) 

[ Bt>mom~ J 

Help 

If you already own a Hard 
Disk 20, use the Installer to 
update the Hard Disk 20 
system files just as you update 
other startup disks. With your 
Macintosh 512K enhanced 
you no longer need to start up 
your Hard Disk 20 with an 
HD 20 Startup disk. 

A Note to LaserWriter Users: 

As a general rule , 
Macintoshes that share an 
AppleTalk network should 
always have identical 
versions of Laser Writer 
printing resources. 
Check version numbers 
of LaserWriter printing 
resources on any installation 
utility programs you have. 
Make sure everyone on your 
network installs the latest 
version number avai lable. 
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Introduction The first part of this chapter describes Macintosh in general. Though some 
details may change from application to application, this is the way Macintosh 
usually works. 

"Finder Reference" and "Finder Menus" get specific about the Finder, the 
application for organizing and managing your documents. This second part of 
the chapter describes the functions and effects of windows, icons, and menus 
in the Finder, and also talks a little about the things the Finder manages. 
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What Macintosh 
512K enhanced Is: 
Its Parts 

Memory Processor 

The basic Apple Macintosh 512K enhanced system includes the main unit, the 
keyboard, and the mouse. The main unit contains the processor, 512K of 
memory, the built-in SOOK disk drive, and the screen. The processor does the 
actual work of the computer. Memory is where the Macintosh 512K enhanced 
stores the information you ' re currently using. The Macintosh 512K enhanced 
can get this information from a disk in the disk drive. (The disk drive records 
and retrieves the information that 's stored on the disks.) The Macintosh 512K 
enhanced can also get information directly from you through the keyboard or 
the mouse or from other peripheral devices. The screen is where you keep track 
of what you ' re doing. These parts of the Macintosh 512 K enhanced that you can 
see and touch are called hardware. 

One of the really exciting things about Macintosh is the software, or 
application programs you can use-like MacWrite for words, MacPaint for 
pictures, MacDraw for structured graphics, MacTerminal™ for electronic 
communications, or MacProject™ for project management. 

You can add to your basic Macintosh 512K enhanced system as your needs 
grow, choosing from a large and constantly growing family of Macintosh 
hardware and software products . 

•• 



Where Does Your 
Information Go? 

When you open an existing document so you can revise it (the perfect first draft 
has yet to be created) , the Macintosh 512Kenhanced leaves the original on the 
disk and makes a copy for you to work on. When you 're done working on the 
copy, you decide whether you want to keep the new version or not. 

If you save the new version with the same name, it replaces the "original" on 
the disk. If you don't, with most applications, the original on the disk isn't 
changed at all . You have the option of saving the new version with the original 
name, saving it with a different name, or not saving it at all. It's like having an 
original document and making photocopies of it to edit. When you ' re satisfied 
with the changes, you change the original. 

The document in the memory of the Macintosh 512K enhanced-the version 
you 're working on-is stored only temporarily. So if you accidentally trip over 
the power cord, or the electricity goes off, everything you 're working on­
whatever's in memory-vanishes forever. To count on your work being there 
when you need it, save it on a disk by choosing Save from the File menu every 
15 minutes or so. That way you '11 never lose more than a coffee break's worth of 
work. 
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Original on disk 

t- Changes you make to 
the copy 

Copy replaces 
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Keyboard 

• Character Keys 

• Special Keys 

The Macintosh 512K enhanced keyboard includes character keys and other 
special keys. 

The character keys are just like keys on a typewriter. Use them to type any 
character, including numbers and symbols such as =,[,and so on. Character 
keys repeat when held down. Use the Control Panel to set the rate of repeating. 
See "Using the Control Panel" in Chapter 2 . 

Some of the Macintosh 512K enhanced keys are used with character keys to 
produce different characters, or to issue menu commands. Others perform 
more specific actions. 

Shift Key 
When Shift is held down, character keys produce uppercase letters or the upper 
character on the key. Sometimes Shift modifies other actions: for instance, in 
the Finder, holding down the Shift key while you click lets you select more than 
one icon. 

Caps Lock Key 
A Shift for letters only. When the Caps Lock key is engaged, letter keys produce 
uppercase letters, but number and symbol keys aren't affected. 
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Option Key 
Generally gives an optional character set of accented and special characters. 
The Option key can be used with Shift and Caps Lock. All optional characters in 
the Chicago font are illustrated in Appendix A. You can also use the Key Caps 
desk accessory to see the optional characters in any font installed in the current 
startup disk's System file. See "Desk Accessories" in this chapter. 

Using the Option key with certain character keys lets you enter accented 
characters. 

Option-' 
Option-e 
Option-i 
Option-u 
Option-n 

' grave accent 
~ acute accent 
A circumflex 
··umlaut 
~tilde 

Typing the Option key combination followed by another character produces 
that character accented with that diacritical mark. If the character can't be 
accented by the mark, you get the mark followed by the character. Typing the 
Option key combination twice gives you the diacritical mark alone. 

Command Key 
Holding down the Command key in combination with another key is often 
a shortcut to choosing a command from a menu. Commands that have 
Command key equivalents list them in the menu. Sometimes the Command 
key modifies other actions: for instance, holding down the Command key 
while typing a period (.) sometimes cancels a long operation in progress­
printing, for example. 
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Enter Key 
Confirms whatever entry (usually text) you've made-an entry typed into a 
blank to name a document, for example. In a dialog box, pressing the Enter key 
is the same as clicking the button that confirms the command (such as OK) or 
the outlined button if there is one. 

Return Key 
Moves the insertion point to the beginning of the next line. In a dialog box, 
pressing Return is the same as clicking the button that confirms the command 
(such as OK) or the outlined button if there is one. 

Backspace Key 
Deletes the current selection. If the selection is the insertion point, backs over 
and deletes text. 

Tab Key 
Moves the insertion point horizontally to the next stopping place (such as a tab 
stop). In dialog boxes, pressing Tab usually selects the next place to supply 
information. 
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Disks 

• Initializing Disks 

98 

Disks store information. Apple 3\12-inch double sided disks store SOO kilobytes 
(or about 160 pages per disk) . (Double-sided disks are inscribed "Double 
Sided" and are lighter in color than single-sided ( 400K) disks.) Some space on 
each disk is used for keeping track of the disk's contents (this is where its 
directory information is actually stored). The amount of space used for the 
directory depends on how much information is on the disk. 

Before your Macintosh 512K enhanced can get information from or save 
information on disks, they need to be initialized in a format it understands. (A 
blank disk is like a parking lot without divider lines. Before it can "park the 
cars," your Macintosh 512Kenhanced has to "draw in the white lines.") Any 
time you insert an uninitialized disk or any disk your Macintosh 512K 
enhanced can't read because it's damaged or initialized for a different kind of 
computer, a message appears, asking if you 'd like to initialize the disk for the 
Macintosh 512K enhanced and whether you want to initialize the disk on one 
side or both sides. 

The Macintosh 512K enhanced SOOK disk drive (and the SOOK external disk 
drive) can read disks initialized with either a one-sided or two-sided format. If 
you're using SOOK disks, you 'll usually initialize them with a two-sided format; 
this gives you the full SOOK of space on the disks, and it also gives you the 
hierarchical file system, which lets you use folders within applications as well 
as in the Finder. The one-sided format gives you a "flat" file system, in which 
folders don't show up within applications. 

But you aren't limited to using only SOOK disks or to initializing disks with a 
two-sided format. You can use 400K disks as well as SOOK disks with your 
Macintosh 512K enhanced. Or you can initialize SOOK disks with a one-sided 
format so you can use them in a 400K disk drive. Here are a couple of things to 
think about when you initialize disks: 

o Be sure to initialize 400K disks one-sided only. Although the Macintosh 512K 
enhanced will sometimes let you initialize a 400K disk two-sided, the second 
side of the disk has not been tested for reliability, and you'll regret the 
decision to initialize both sides the day you lose all the information on the 
disk. 

o You can't use an SOOK disk in a 400K disk drive if you've initialized it two­
sided. In this case, a dialog box asks if you want to initialize the disk with a 
format it can read. Clicking Initialize erases all the information on the disk. 
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It's fine to use a combination of one- and two-sided, 400K and SOOK disks. 
You'll notice the difference between one- and two-sided formats whenever 
you choose Open or Save As within an application. With disks formatted on one 
side only, you won't see folders; with disks formatted on two sides, you'll see 
the same folders you create in the Finder. 

400K SOOK 
disk drive disk drive 

400K disk yes yes* 
initialized 
one-sided 

400Kdisk no no** 
initialized 
two-sided 

SOOK disk yes yes*** 
initialized 
one-sided 

SOOK disk no yes 
initialized 
two-sided 

*You may want to copy applications from 400K disks to two-sided SOOK disks. 
Some applications, however, may be copy-protected. You can continue to use these 
applications from one-sided 400K disks. 

* * 400 K disks are certified on one side only. 

***SOOK disks can be initialized one-sided, but you '11 be able to use only 400K on the disk and 
you won't see folders within applications on this disk. 

You can initialize disks while you're using an application without losing any 
information in memory. 

You can also initialize disks that have information on them by using the Erase 
Disk command in the Special menu in the Finder. Of course, this erases 
everything on the disk. 

You can copy a 400K disk to an SOOK disk, and gain the extra 400K for your 
own work. 
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• Locked Disks 

100 

You can prevent information on a 3Y2-inch disk from being changed by sliding 
the small tab toward the edge of the disk. This is called locking a disk. 

When a disk is locked, you can't add new information to it or change any 
information on it. You can open (and perhaps print) the documents it contains, 
but you won't be able to save, delete, rename, move, duplicate, or change any 
information on it. 

To allow the disk to be altered again, slide the tab to cover the hole. 

Some applications may not work with a locked disk, and the Finder can't 
reconstruct anything you've done on the desktop when you' re using a locked 
disk. Some desk accessories may not work properly if the current startup disk 
is locked. 

Locked Unlocked 
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• Names of Disks 
and Documents 

Every disk, document, application, and folder has a name. You name disks 
when you initialize them; you name documents when you save them for the 
first time, and you usually name folders when you create them. You can change 
a name at any time with the Finder. 

There are a few restrictions to the names you can give. A disk name can contain 
up to 27 characters; a document or folder name can contain up to 31 characters. 

A name can't contain a colon(:) and shouldn't begin with a period(.). Other 
than that, you can use any characters you can type on the keyboard. 

With the Macintosh 512Kenhanced, you can have multiple documents or 
folders with the same name as long as they're in separate folders and the disk is 
initialized two-sided. You can't have two items with the same name in the same 
folder. When comparing names, your Macintosh 512Kenhanced considers 
uppercase and lowercase letters to be equal, so "saturday" and "Saturday" are 
the same. 

It's best not to give documents the same name as applications. If you move a 
document named "MacWrite" to a folder that has the MacWrite application in 
it, you'll be asked if you want to replace the existing MacWrite. Clicking OK 
will discard the application. 

It's a good idea to keep disk names different, too: sometimes the Macintosh 
512K enhanced will ask you for a specific disk by name, and it's confusing to 
have a lot of disks with that same name (your Macintosh 5 l 2K enhanced can be 
quite picky about which one it wants). It's also a good idea to write the disk's 
name on its label. 
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Startup Disks 

• Customizing 
Startup Disks 
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The Macintosh 512K enhanced System Tools disk that came with your 
Macintosh 512K enhanced contains system files the Macintosh 512K 
enhanced needs to get itself started. Disks that contain these files are called 
startup disks. These system files are originally stored in a System Folder, and 
it 's a good idea to keep them there. 

A startup disk always includes at least a System file and a Finder. It also usually 
includes at least one printing resource, such as the Image Writer, AppleTalk 
Image Writer, or LaserWriter file on the System Tools disk. You may also find 
other system files on a startup disk: Scrapbook File, Clipboard File, etc. 
These files contain information that 's used only by certain applications and 
desk accessories. 

Besides giving the Macintosh 512K enhanced the information it needs to get 
itself started, the system files on the startup disk determine 

o which fonts you have available when you use an application (they' re in the 
System file on the startup disk you're using) 

o which desk accessories are in the Apple menu (they're also in the 
System file) 

o what's in the Scrapbook desk accessory ( whatever's in the Scrapbook file on 
the startup disk) 

o which version of the Finder you' re using 

It's a good idea to keep all of your startup disks current with the latest system 
files. For example, some applications' startup disks may not have the most 
current system files. You can create new startup disks with the two-sided 
format or update existing startup disks. See "Using the Installer" in Chapter 2. 

You can use the Font/DA Mover (Font and Desk Accessory Mover) to 
customize the System file on startup disks so it contains the fonts and 
accessories you want available when you use applications with that disk. 
Applications you purchase may already be customized with fonts or 
accessories suited to that particular application. The Font/DA Mover lets you 
copy these to any other startup disk as well. See ''Using the Font/DA Mover'' 
in Chapter 2. 

You can also customize a startup disk by dragging to it other system files such as 
the Scrapbook or Clipboard file- to have different Scrapbook contents 
available from time to time, for example. 
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• Current Startup 
Disk 

When you start your Macintosh 512K enhanced, it looks for a startup disk in its 
internal disk drive; if it finds none there, it looks in an external drive if one's 
attached. Finally, it searches for any hard disks. The first startup disk the 
Macintosh 512K enhanced finds becomes the current startup disk, the disk 
whose system files the Macintosh 512K enhanced is currently using. 

The Macintosh 512K enhanced can switch to a different startup disk while 
you're working. You can also force the Macintosh 512K enhanced to switch 
when you want another disk to be the current startup disk (if you want to use 
different fonts or desk accessories, for example). 

The Macintosh 512K enhanced switches to a different startup disk whenever 

o You restart the Macintosh 512K enhanced using a different startup disk. The 
Macintosh 512K enhanced follows the normal order in looking for a startup 
disk. 

o You explicitly open an application (not a document) on another startup disk. 
(If you're using a hard disk, this doesn't cause a switch.) 

o You open a document on another startup disk and the original startup disk 
does not contain the document's application. (If you're using a hard disk, 
this doesn't cause a switch.) 

You can also force the Macintosh 512K enhanced to switch to a different startup 
disk. You can do this in one of the following ways: 

o Hold down the Option key while you open an application. (This forces 
a switch whether or not other conditions are met, as long as the application 
is on a startup disk; it's especially useful if you have a hard disk.) 

o Hold down the Option and Command keys while you double-click the 
Finder icon on the disk you want to switch to. 

When you're using the new hierarchical file system, all system files must 
be together in the same folder. 
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• Arranging Your 
Work on Disks 
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In general, how you arrange your work on disks depends on the size of your 
Macintosh 512K enhanced system, the printer or printers you 're using, and the 
way you want to organize your work. Macintosh lets you arrange documents, 
folders, and applications however you want on your disks. See "Copying or 
Moving a Document, Folder, or Application to a Different Disk" and 
"Removing or Recovering a Document, Folder, or Application" in Chapter 2. 

You do need to start your Macintosh 512K enhanced using a startup disk, and 
you'll probably want an application on that disk or a disk in a second disk drive. 
Of course, the bigger your Macintosh 512 K enhanced system, the more 
flexibility you have. 

o If you're using a one-drive system, you can minimize the amount of "disk 
swapping" you have to do by keeping just one application and documents 
you create with that application on a startup disk. Of course, you can copy 
applications to as many startup disks as you need. 

o If you 're using a two-drive system, you might decide to keep more than 
one application on a startup disk in the internal drive and keep documents 
you create with those applications on non-startup disks in the second disk 
drive. It's a good idea to keep about SOK available on your startup disks. 
Applications usually need a little working space on the current startup disk, 
even if the document you' re working on is on another disk. 

If you need more space on your startup disks-if you have AppleTalk 
and a LaserWriter with many fonts installed, for example-you can keep 
applications together with documents on non-startup disks in the second 
disk drive. 

There are a couple of other things you can do to save space on startup disks 

o Drag any printing resources you don't need to the Trash. For example, if you 
use an Image Writer without Apple Talk exclusively, you can drag the 
AppleTalk Image Writer and LaserWriter files to the Trash. 

o Remove fonts or desk accessories you don't need from its System file. 
See "Using the Font/ DA Mover" in Chapter 2. 

When the information you need spreads to more disks than you can easily 
handle, the best solution is an Apple Hard Disk 20™. With it you can keep 
everything on the hard disk, and use 3Yz-inch disks just to get information 
on or off the hard disk. See the Hard Disk 20 owner's guide . 
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Windows . Windows present information. You can have multiple windows on your 
desktop so you can view more than one set of information at the same time. 
Most windows can be moved, changed in size, scrolled through, or closed. 
They can also overlap each other. When more than one window is open, one 
is frontmost, and that's where all the action happens. Clicking anywhere 
in a window brings it to the front and makes it active. 

Although a window may be "buried" under others, it cannot be dragged 
completely off the screen or made so small that you can't see it. 

s File Edit Uiew Special Key Caps 

System Tools 
2 items 425K in disk 

Information about System Tools 

rTill System Tools [DJ 
disk 

Ke Caps 

Windows may behave a little differently within an application. See each 
application's manual for an explanation of windows in that application. 

Windows 105 



Clipboard: Cutting 
and Pasting 
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You can move information within a document, among documents created with 
the same application, among documents created with different applications, 
or among desk accessories and documents. The information you ' re moving or 
copying is held on the Clipboard. The Cut, Copy, and Paste commands in the 
Edit menu let you move information between the Clipboard and the active 
window. Most applications have a Show Clipboard command in their Edit 
menu that shows you the current contents of the Clipboard. 

Within an application, the contents of the Clipboard keep attributes such as text 
sizes and styles, or any information unique to that application. When moving 
between applications, usually only the text or the picture, in a fixed format, 
is exchanged. 

The Clipboard contents are kept in the Macintosh 512K enhanced memory, if 
possible. If the contents grow too large, they are temporarily saved in the 
Clipboard file on the current startup disk. 
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Dialog Boxes Whenever the Macintosh 512 K enhanced needs more information from you, it 
displays a dialog box, with buttons to click and sometimes with space for you to 
type additional information, such as the name for a new document. 

If you 're about to do something that could cause you to lose information, a 
message in the dialog box alerts you and asks you to confirm that you want to 
proceed anyway. In boxes containing these messages, one of the buttons-the 
"safest" alternative-is usually boldly outlined. Pressing the Enter or Return 
key is the same as clicking the boldly outlined button or, if none, the button that 
confirms the command. 

A warning message may be accompanied by one or more beeps. If loud beeps 
annoy you, use the Control Panel desk accessory to lower the speaker volume. 
(If you turn the speaker volume all the way off, the menu bar blinks to warn you 
even more subtly.) See "Using the Control Panel" in Chapter 2. 
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Desk Accessories 

• Alarm Clock 

You choose desk accessories from the Apple menu on the far left side of the 
menu bar. Desk accessories are available while you're using the Finder or any 
application. 

You can use the Cut, Copy, and Paste commands in the Edit menu to move or 
copy text or pictures among desk accessories or to or from another window. 
See "Editing Text" in Chapter 2. 

With most applications, you can keep one or more desk accessories open 
on your desktop while you work on documents. Like any windows, desk 
accessories may be obscured by other windows that are made active . The 
accessories can be made active by clicking them or choosing them again from 
the Apple menu, and moved by dragging their title bar. You close them either 
by clicking their close boxes or by choosing Close from the File menu. 

With some applications (MacPaint, for example), you need to close desk 
accessories in order to work on a document. 

All desk accessories are closed automatically when you open a document 
or application from the Finder or quit an application. 

The Apple menu always contains the accessories that are installed in the 
System file on the current startup disk. The System Tools disk includes two desk 
accessories-the Note Pad and the Puzzle-in a desk accessory file in the 
Utilities folder. You can add these accessories to any startup disk. See "Using 
the Font/DA Mover" for how to add or remove desk accessories. 

- --Lever 
f-------=-1 

Alarm button -----"' --Alarm 

Date--------'---' 
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When you choose Alarm Clock, a compact clock displays the hour, minute, and 
second. To see more, click the lever on the right side of the clock. (Click the 
lever again to go back to the compact clock.) With the lever down, two more 
panels appear. The middle panel displays and provides a place to set whatever 
you select by clicking in the bottom panel-the time, date, or alarm setting. 

Set what's currently displayed in the middle panel by clicking the digits you 
want to change. Arrows appear on the right. Click the up or down arrow to 
scroll the numbers higher or lower. Or use the keyboard to type the numbers. 
Click the top panel to set. 
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• Calculator 

•Chooser 

Click the alann button to set or unset the alarm. Your Macintosh 512K 
enhanced beeps when the alarm goes off, and the Apple menu title blinks until 
you unset the alarm by clicking the alarm button off. Choosing Alarm Clock 
from the Apple menu also turns the alarm off, but it doesn't unset it. 

When the clock is active, the time and date are automatically selected (even 
though they aren't highlighted), so you can copy and paste them into the 
document you're working on or into a desk accessory that accepts text. 

The Calculator works like an ordinary four-function pocket calculator, except 
that with your Macintosh 512K enhanced calculator you can copy the 
calculation results (which are automatically selected) and paste them into any 
document or another desk accessory. You can also copy numbers from a 
document and paste them into the calculator's display. 

Click the buttons or type on the keyboard. The * is multiplication; the I is 
division. 

If you' re using an Image Writer printer exclusively, you probably won't use the 
Chooser desk accessory. The Macintosh 512K enhanced is preset to print 
documents on any Image Writer attached to the Printer port whenever you 
choose Print from the File menu. You'll use the Chooser only if you have 
another printer or if you want to use a different port for the Image Writer (if 
you've connected Apple Talk to the Printer port, for example). 

The Chooser lets you print from any attached printer for which there's a 
printing resource on the current startup disk. (A printing resource is a system 
file that usually has the same name as the printer itself.) 
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• Control Panel 

• KeyCaps 

110 

The System Tools disk includes printing resources for the Image Writer (which 
works with either an Image Writer or an Image Writer II), LaserWriter, and 
AppleTalk Image Writer (which lets you use an Image Writer II with an 
installed Apple Talk card on AppleTalk). You can use the Chooser to print on 
any of these printers. If you ' re using an Image Writer exclusively, you can make 
more space available on the disk by dragging the LaserWriter and AppleTalk 
Image Writer icons to the Trash. 

To use the Chooser to print with a LaserWriter or AppleTalk Image Writer, see 
"Using the Chooser" in Chapter 2. 

You can update any other startup disks you use with your Macintosh 512K 
enhanced to have the same printing software and other system updates 
included with the System Tools disk. Or you can create new Macintosh startup 
disks . See "Using the Installer" and "Creating a Startup Disk" in Chapter 2. 

The Control Panel lets you set your preferences for such things as speaker 
volume, repeating key rate, whether or not AppleTalk is connected, and even 
the background pattern of your desktop. Most Control panel settings are 
remembered by the Macintosh 512K enhanced itself and aren't affected by the 
current startup disk. (This is in contrast with the Chooser settings, most of 
which are stored in the System file of the current startup disk.) When you 
switch your Macintosh 512K enhanced off, the battery provides power for your 
Macintosh 512K enhanced to remember the settings. 

See "Using the Control Panel" in Chapter 2. 

Press the Option, Shift, or Caps Lock key or press the Option and Shift keys 
together on the Macintosh 512K enhanced keyboard; the Key Caps desk 
accessory displays the characters you can type while holding down that key or 
combination of keys . 
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You can either type the character you want on the keyboard or just click it in the 
Key Caps accessory. 

See "Keyboard" in this chapter for how to produce accented characters using 
the diacritical marks in the optional character set. 

When the Key Caps accessory is the active window, a Key Caps menu appears 
in the menu bar. The menu always contains the fonts installed in the current 
startup disk's System file. (These are the fonts that will be available in any 
application you use with this startup disk.) Choosing a font lets you see each 
of its characters. With any font you choose, you can use the Option, Shift, and 
Caps Lock keys to see the characters each key or combination of keys produces. 

Text you type on the Macintosh 512K enhanced keyboard or "type" by clicking 
Key Caps keys appears in the blank at the top of the Key Caps window. You can 
edit this text in the usual way and cut and paste it among other desk accessories 
or any document. 
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• NotePad 
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D Note Pad 

Sue, 

Call me after lunch. 

Chri s 

The Note Pad is included in the desk accessory file on the System Tools disk; 
use the Font/DA Mover to install it on any startup disks you want. See "Using 
the Font/DA Mover" in Chapter 2. 

With the Note Pad you can jot down a few notes and keep them separate from 
the document you' re working on. Or type text and edit it even if you' re using an 
application that doesn't allow text editing in the usual way. Use the Edit menu 
to cut and paste into and out of the Note Pad. 

You have eight numbered pages of Note Pad paper. Turn to the next page by 
clicking the turned-back corner of the previous page. Turn to the previous page 
by clicking the bottom-left corner of the Note Pad. 

Notes you type are automatically saved and stored in the Note Pad file on the 
current startup disk. You can copy Note Pad files among disks or remove them 
to gain space on the disks. You can keep more than one Note Pad file on the 
same disk by renaming one of them or keeping it in another folder. When you 
choose Note Pad from the Apple menu, you always see the Note Pad whose 
contents are in the same folder as the System file and Finder on the current 
startup disk. 
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• Puzzle 

• Scrapbook 

The Puzzle is included in the desk accessory file on the System Tools disk; 
use the Font/DA Mover to install it on any startup disks you want. See "Using 
the Font/DA Mover" in Chapter 2. 

The Puzzle gives you something to play with when you need a short break. 
Click a ''tile'' to slide it into the empty space. Try to place the numbers in order. 
The Puzzle reassembles whenever you close it or when it's active and you 
choose it again from the Apple menu. Unfortunately, you can't pry the little 
tiles out when you get frustrated. 

Keep pictures and text you use frequently in the Scrapbook. For example, 
you might keep your letterhead there, or favorite illustrations from MacPaint. 
Paste something you cut or copied from another desk accessory or a document. 
And copy or cut the current picture or text (which is automatically selected) to 
paste into other documents or desk accessories. Use the scroll bar to look 
through the Scrapbook. 

The contents of the Scrapbook are stored in the Scrapbook file on the current 
startup disk. You can copy Scrapbook files among disks or remove them to gain 
space on the disks. You can keep more than one Scrapbook file on the same 
disk by renaming one of them or keeping it in another folder. When you choose 
Scrapbook from the Apple menu, you always see the Scrapbook whose 
contents are in the same folder as the System file and Finder on the current 
startup disk. 

See "Using the Scrapbook" in Chapter 2. 
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Switch 

Finder Reference 

• Overview 

114 

The programmer's switch is included for people who want to write application 
programs for the Macintosh 512Kenhanced. See Appendix C if you 're one of 
these people. Otherwise, ignore the switch; installing it and using it in the 
wrong way could cause you to lose information. 

The Finder is Macintosh's application for managing documents and directing 
traffic between you and the disk. 

The Finder is like a central hallway in the Macintosh 512Kenhanced house. It 
manages moving from one application to another (like rooms in the house) 
and organizing the documents you create with those applications. It's the way 
you enter the Macintosh 512K enhanced house-and it's the link between you 
and your disks, giving you access to the documents you store on them. 

Common Finder tasks include 

o opening, closing, copying, discarding, moving, and renaming documents, 
folders, applications, and disks 

o organizing documents, applications, and folders on the desktop, in folders, 
and on disks 

o ejecting and initializing disks 

/ Macintosh \ .............. 
0 

Chapter 3: Reference 



• What the Finder 
Manages 

Some of the Finder's capabilities are also available while you're using an 
application. You can open new documents, save work on disk (using the same 
folders that appear in the Finder), examine the contents of disks and their 
folders, eject disks, print the current document, or return to a previous version 
of a document without returning to the Finder. 

You work in the Finder by selecting and dragging icons (see "Selecting Icons" 
and "Dragging Icons" later in this chapter) and by choosing commands from 
menus (see "Finder Menus" later in this chapter). 

Applications and Documents 
Applications and documents are represented in their closed state as icons. 
You can open, close, rename, duplicate, discard, or organize applications 
and documents on disks and in folders. 

Disks 
The contents of disks are displayed in directory windows. Disks can contain 
documents, applications, and folders. Each item is represented by an icon that 
you can select and drag; you can choose to see disks' contents arranged in 
several ways with the View menu. 

A disk currently inserted into either the internal or external disk drive appears 
as a white disk icon (black if it's selected). The icon becomes hollow when its 
window is opened. The icon for a disk that has been ejected appears dimmed in 
gray. (Both inserted and ejected icons are highlighted when selected.) The 
Macintosh 512K enhanced remembers the contents of a disk inserted and then 
ejected (unless you drag the dimmed icon to the Trash or you ejected the disk 
by dragging its icon to the Trash). You can open an ejected disk (or any folder 
inside it) into a directory window; any items on the ejected disk also appear 
dimmed. You can manipulate a dimmed icon just like an icon that's not 
dimmed. The Macintosh 512K enhanced will ask you to reinsert the ejected 
disk when it needs it. If you want the Finder to remove an ejected disk's icon 
from the desktop and never ask for the disk again, you can drag the ejected 
disk's icon to the Trash. You can also drag an inserted disk's icon to the Trash to 
both eject it and remove its icon from the desktop. 

See "Startup Disks" and "Arranging Your Work on Disks" in this chapter for 
more information about disks. 
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Folders 
Folders are receptacles that allow you to arrange your applications and 
documents hierarchically on a disk. When opened, folders display their 
contents in directory windows, just like disks. Folders can contain other 
folders. 

You make new folders using the New Folder command in the File menu. 

Whenever you choose Open or Save As from the File menu within an 
application or you save a document for the first time using the Save command, 
you see the same hierarchy of folders you created in the Finder, as long as the 
disk is initialized two-sided. See "Initializing Disks" and "Summary of 
Managing Documents Within an Application" in Chapter 2. 

The first directory you see when you choose Open or Save As is the folder 
(or disk if you' re at the top level) that you last saved a document to or opened a 
document from. You can move up or down the hierarchy to open documents 
from or save documents to any level in the hierarchy. You can have documents 
or folders with the same name on the same disk, as long as they're in different 
folders. 

Desktop 
The desktop in the Finder is a handy temporary resting place for icons. If you' re 
concentrating on only a few documents and applications at a time, and they're 
on different disks or in different folders, you can drag all the documents to 
the desktop and work on them there. You can even close the windows for the 
folders and disks they came from; the Finder will remember where the 
documents belong. 

You can put icons back where they came from by selecting them on the desktop 
and choosing Put Away from the File menu. 
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• Selecting Icons 

• Dragging Icons 
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Trash 
The Trash is a receptacle for discarding documents and folders. You can't 
discard disks this way. Instead, dragging a disk to the Trash ejects the disk 
and removes its icon from the desktop. (If the disk is the current startup disk, 
dragging its icon to the Trash ejects it but leaves the icon on the desktop.) 
When you discard a folder, the folder and its entire contents disappear. Locked 
documents can't be discarded; you must unlock them (by selecting them, 
choosing Get Info from the File menu, and clicking the checked Locked box) 
before discarding. 

When you open the Trash icon, it shows the last few documents you discarded. 
You can recover those documents by dragging them out of the Trash back onto 
the desktop. But documents stay in the Trash only for a short while; the Finder 
empties the Trash when it needs the space . You can reclaim the space 
immediately by choosing Empty Trash from the Special menu. 

Once an icon is selected, the Edit menu commands operate on that icon's 
name (unless it's locked), and the File menu commands work on what the 
icon represents. 

When more than one icon is selected, the editing commands in the Edit menu 
are dimmed. 

You can select a group of icons only if they' re all in the same window or all on 
the desktop. If you want to work on a number of documents in different folders 
or disks, drag them to the desktop and select them all there. 

Operations on a group of icons are performed one by one-printing a group of 
documents, for example. The icons are taken in order from left to right, top to 
bottom. 

Dragging an icon from one place to another moves that icon to the new place. 
You can drag an icon onto the desktop, onto a folder, disk, or Trash icon, or into 
an open folder, disk, or Trash window. 

Dragging an icon from one place to another on the same disk (or to a folder on 
the same disk) merely moves the icon to the new place. Dragging an icon to 
another disk (or to a folder on that disk) leaves a copy behind on the original for 
safekeeping. If you don't want the copy left behind, just drag it to the Trash 
afterward. 
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If you drag an icon to another disk and there's already an icon with that same 
name on that disk, you' re asked if you want to replace it with the icon you' re 
dragging. 
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You can drag locked documents; you can't drag anything to or from a locked 
disk. See the Get Info command in "The File Menu" in "Finder Menus" in this 
chapter. 
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Finder Menus 

• The Apple Menu 

• The File Menu 
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Each Macintosh application presents the commands it can carry out in menus 
you pull down from the menu bar. Together with dragging icons, the Finder's 
menus allow you to do all your desktop-management tasks. 
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About the Finder ... 

J 

Shows the version number and the authors of the Finder, as well as the memory 
size of the Macintosh 512K enhanced you're using. 

Desk Accessories 
Choosing any of the desk accessories causes that accessory to appear on the 
desktop. You can use the Edit menu to cut, copy, and paste the information 
in most desk accessories. 

The desk accessories are explained more fully in "Desk Accessories" earlier 
in this chapter and in ''Using Desk Accessories'' in Chapter 2. 
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The commands in the File menu operate on icons and windows. 
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New Folder 
Creates an empty folder that can hold documents, applications, or other 
folders. New folders appear in the active window on the desktop. The 
command is dimmed if no directory windows are open. See "Folders" 
in "Finder Reference" in this chapter. 

Open 
Opens the selected icon into a window. If the icon represents a document, 
opening it also starts an application so you can work on the document. If the 
icon represents an application, opening it gives you a new, untitled document. 

In order for you to open a document, the application that created it must be on 
a currently inserted disk. 

If you select a document and an application, the Finder attempts to use that 
application with the document. For example, selecting MacWrite along with 
a text-only document you created with MacTerminal opens MacWrite to work 
on the text-only document. 

If you select more than one icon and choose Open, the Finder attempts to open 
the first icon's application to work on all the other selected icons. 

Print 
Prints the document represented by the selected icon or icons, in left to right, 
top to bottom order. Usually, the documents must be created by the same 
application. 

In order to print a document, you must have the application that created it on 
a disk whose icon appears on the desktop. Document printing from the Finder 
follows the same rules and procedures of printing in that document's 
application. 

With most applications, when you choose Print a dialog box appears. Select the 
options you want and click OK or press the Return key. See each application's 
manual for more information on how to print with that application. See each 
printer's manual for information about using that printer. 

Close 
Closes the active window, zooming it back down to its icon. The icon remains 
selected. (If the active window is a desk accessory, it just disappears into thin 
air.) The next frontmost window, if there is one, then becomes the active 
window. 
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Get Info 
Opens a window that displays information about whatever the selected icon 
represents. The displayed information includes the kind of item (document, 
folder, or application, and if it's a document, which application created it), 
the date it was created, the size, which disk and drive it belongs to, and the 
date it was last changed. You can still drag or open a selected icon while its 
information window is open. 

You can add text by typing in the place for comments and editing it as you edit 
any text. 

The Locked check box allows you to lock a document or application. When the 
Locked box is checked, that document or application can't be disposed of and 
its name can't be changed. You can't save any changes to a locked document. 

Duplicate 
Duplicates the selected items on the same disk. The duplicates are named 
"Copy of," followed by the name of the original. 

Duplicating a folder duplicates the folder and all its contents, even if the 
contents are out on the desktop rather than inside the folder. 

Put Away 
Puts away any selected documents, folders, or applications on the desktop 
or in the Trash window back to the folders and disks they belong to. If a disk 
icon is opened into a directory window, the items you put away appear there; 
otherwise they will appear the next time you open the disk icon. This 
command is dimmed when no icons are selected on the desktop or in the 
Trash window. 

Page Setup 
Lets you set up the page size, orientation, and other options for directories you 
print using the Print Catalog command. The Page Setup command doesn't 
work with documents you print from the Finder; a document's page setup 
is controlled by the Page Setup command within each application. 

Print Catalog 
Prints the contents of the active directory window, in whatever view you have 
the directory arranged. 

Chapter ) : Reference 



• The Edit Menu 

Eject 
Ejects the selected disk, or the disk represented by the active window. If no 
disk is selected, the Finder looks for any inserted disk to eject, starting with the 
current startup disk. Whenever a disk has been ejected, its icon and the icons 
belonging to it are dimmed to show they're no longer available. (You can also 
eject a disk by dragging its icon to the Trash.) 

lit File 

Cut seH 
copy sec 
Paste seu 
Clear 
Select Rll sen 

Show Clipboard 

The Finder's Edit menu allows you to edit 

o the names of disks, documents, applications, or folders 

o text in an information window (opened by selecting the icon and choosing 
Get Info from the File menu) 

o text or pictures in desk accessories 

You cannot use this menu to cut or copy icons. You do this by dragging icons. 
See "Dragging Icons" in "Finder Reference" in this chapter. 

Selecting an icon also selects its title. Anything you subsequently type replaces 
the old text. Clicking the selected text itself causes an insertion point to appear. 
You can edit this text as you edit any text. 

Undo 
Undoes your last text-editing action in desk accessories that use text. It may 
undo other actions in some desk accessories. 

Cut 
Removes the selection and places it on the Clipboard, replacing the previous 
contents if any. 

Copy 
Places a copy of the selection on the Clipboard, replacing the previous contents 
if any. 
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• The View Menu 
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Paste 
Puts a copy of the contents of the Clipboard at the insertion point. You can 
continue to paste copies until you cut or copy a new selection, which replaces 
the old contents of the Clipboard. 

Clear 
Removes the selection, without placing it on the Clipboard. 

Select All 
Selects all icons in the active window or, if no windows are open, all icons 
on the desktop. 

Show Clipboard 
Displays a window with the current contents of the Clipboard-that is, 
whatever you last cut or copied . 

l s File Edit mtn:·ITOlll Special 
by Snfall I con 

v'by Icon 
by Name 
by Date 
by Size 
by Kind 

You might keep your directory windows arranged by icon most of the time. 
But the commands in the View menu also let you view directories of disks, 
folders, or the Trash in other arrangements. 

In any text view of a disk or folder directory, small icons appear to the left of 
each document, folder, or application title . Icons and text in titles behave the 
same way in whatever view you choose. Clicking either an icon or its title 
selects the item; the pointer then becomes an arrow over the icon itself and 
an I-beam for editing the item's title . Dragging an unselected icon or title 
moves or copies the item. 

The current view of the active window is marked in the View menu by a check. 

By Small Icon 
Shows the contents of the active directory window with small icons to the left of 
the icon names. This view is especially helpful when you have large numbers 
of documents and applications on a disk-if you have a hard disk, for example. 
You can hold down the Option key while you choose Clean Up from the 
Special menu to display the contents neatly and compactly. 
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• The Special Menu 

By Icon 
Shows the contents of the active directory window as icons, just as on 
the desktop. 

By Name 
Lists the contents of the active directory window alphabetically by name. 
Uppercase and lowercase are considered equal. 

By Date 
Lists the contents of the active directory window chronologically by 
modification date. The document you changed most recently is listed first. 
Folders' modification dates indicate when you created them or when you 
changed their contents by adding or removing items from them. 

By Size 
Lists the contents of the active directory window by size, largest first. Useful for 
seeing which of your documents are taking the most room on the disk. Folders 
are listed according to the size of their contents. 

By Kind 
Lists the contents of the active directory window by kind-whether each item 
is a document, application, or folder. For a document, it tells which application 
created it. 

s File Edit Uiew 

~·~t S1<1r1ll!I 
U~f~ Mio ff ind Hr"' 

Shut Down 

Clean Up 
Used only in By Small Icon and By Icon views. Arranges all icons in the active 
window in neat rows and columns. If no directory windows are_open, Clean 
Up cleans up the desktop. 

Empty Trash 
Removes the contents of the Trash and makes the space it took on the disk 
available for you to use immediately. Also, the Finder empties the Trash 
automatically whenever it needs the space. 
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Erase Disk 
Initializes (and completely erases) the disk whose icon is selected. You' re then 
offered the usual choices to initialize the disk. See "Initializing Disks" in 
"Disks" in this chapter for more information about initializing disks. You can't 
erase the current startup disk because the Macintosh 512K enhanced needs 
information on that disk in order to work. If you want to erase a certain disk, 
start the Macintosh 512K enhanced using a different disk, eject that disk if 
necessary, and insert the disk you want to erase. 

Set Startup 
Lets you jump immediately into an application without going through the 
Finder. You set the startup application by selecting it in the Finder and 
choosing Set Startup. The next time you start your Macintosh 512K enhanced 
using this disk, you'll go immediately into the application. To reset the startup 
place to the Finder, quit the application, select the Finder icon (first open the 
System Folder, if necessary), and choose Set Startup again. 

Use MiniFinder ... 
Saves you time in moving among the documents and applications you're 
currently using the most. See "Using the MiniFinder" in Chapter 2 for how 
to use the MiniFinder. 

Shut Down 
Ejects any inserted disks (first saving any necessary information), and then 
restarts the Macintosh 512K enhanced. This is not only a shortcut but the best 
way to restart the Macintosh 512K enhanced using a different startup disk. 
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Macintosh 
Shortcuts 

• Double-Click 

• Shift-Click 

• CloseBox 

• ZoomBox 

• Enter and Return 
Keys 

• TabKey 

• Backspace Key 

In general, Macintosh shortcuts are just quicker ways to do things you can 
ordinarily do '' the long way.' ' Some shortcuts apply only to a specific 
Macintosh application; each application's manual explains its own. 

Double-clicking an icon opens it. In text, double-clicking a word selects the 
entire word. 

Holding down the Shift key and clicking adds to an existing selection. As long 
as you hold the Shift key down, the first selection isn't deselected when you 
make a new selection. Shift-clicking in an extended selection deselects. In 
some applications, Command-click also performs a similar function . 

Clicking the close box in the title bar of the active window closes it, just like 
choosing Close from the File menu . 

Clicking the zoom box on the right side of an active window's title bar expands 
the window to full size. Clicking the zoom box on an expanded window 
returns it to its former position and size. 

Pressing the Enter or Return key in response to a dialog box is the same as 
clicking the button that confirms the command or the outlined button if there 
is one. 

Pressing the Tab key in a dialog box usually selects the next place to supply 
information. 

In the dialog boxes you see when you choose Open or Save As within an 
application, pressing the Tab key is the same as clicking Drive. 

Using the Backspace key with a selection is the same as choosing Clear from the 
Edit menu. Unlike using the Cut command, using the Backspace key doesn't 
put what's deleted on the Clipboard. 
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• OptionKey 

• Command Key 

• Selecting by 
Typing 
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Holding down the Option key during the entire initialization process installs 
the hierarchical file system on a 400K disk (or one side of an SOOK disk). This 
is the same file system you get when you initialize an SOOK disk two-sided, 
but it's placed on one side of the disk only. Use disks initialized this way only 
with updated startup disks. 

You can issue many commands (including most commands in the Edit menu) 
by holding down the Command key while you type a character. Commands 
that have Command-key equivalents list the key to type to the right of the item 
inthe menu . 

Holding down the Command key while typing a period(.) sometimes stops 
whatever's happening-printing a document, for example. 

Holding down the Command and Shift keys while typing the number 1 ejects 
the internal disk; holding them down while typing the number 2 ejects the 
external disk. If you 're using an application and there are any open documents 
with unsaved changes, you may lose those changes if you eject disks this way; 
if you 're not sure whether there are unsaved changes, it's better to eject disks in 
the normal way, clicking an Eject button, choosing Eject from the File menu 
(or using the Command-E equivalent), dragging a disk icon to the Trash, or 
choosing Shut Down from the Special menu. 

Holding down the Command and Shift keys while typing the number 3 creates 
a MacPaint document with the current contents of the screen. 

Holding down the Command and Shift keys while typing the number 4 prints 
the current contents of the active window. 

With the Caps Lock key down, holding down the Command and Shift keys 
while typing the number 4 prints the contents of the entire screen. 

In the directory that appears when you choose Open within an application, any 
characters you type are matched character for character to select names in the 
directory. If you type a ''b,'' the first name beginning with a "b" (or the first 
name to follow alphabetically if there are no "b "s) is selected; as you continue 
to type, additional characters are matched. If you type "br", for example, the 
first name beginning "br" is selected, and so on. The Delay Until Repeat 
setting in the Control Panel determines how long you can pause between 
characters before the Macintosh 512 K enhanced considers the next character a 
new request. See "Using the Control Panel" in Chapter 2. 
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Finder Shortcuts These shortcuts are specific to the Finder. Most of them let you do "expert" 
functions. 

Hold down Do this Get this result 

Choose Close from the 
File menu 

Closes all open windows 

LJ 
Choose Clean Up from Realigns from scratch each icon in the active directory 
the Special menu (in window to the grid pattern 
icon views) 

Double-cl ick a disk or Opens the icon, but after you open an application or 
folder icon document in the window, the window is closed when 

you return to the Finder 

Drag a window Moves the window without making it active 

1 ~ ij 
Dragan icon Aligns the icon with the grid the Clean Up command 
(in icon views) in the Special menu uses 

Double-click a hollow Makes that icon 's window active. 
icon 

LJ 
Double-click a Finder Makes the disk the Finder is on the current startup disk 
icon 

1 ~ ~ 
When the Finder Rebuilds the desktop file. You lose any comments 
encounters a disk in the Ger Info windows, but you gain speed. 

No Key Drag a disk to the Trash Ejects the disk, and removes its icon from the desktop 
if it 's nor the current startup disk 

Before switching on, Bypasses the memory test so you quickly get to the 
hold clown the mouse desktop 
button just until after 
the beep 
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Applications 

• MacWrite 

No matter what kind of work you have to do , there 's a Macintosh application 
to help you do it. 

With MacWrite you create documents that look the same on the screen as they'll 
look when you print them. Rather than working around a lot of commands 
embedded in your text, you always see what you've really got. You use the 
mouse to select text and remove, copy, or move it. You can customize your 
documents with many fonts and styles, and you can control margins or line 
spacing with a single click. 

You can add MacPaint or MacDraw graphics to documents you create with 
MacWrite or vice versa. With Macintosh, words and pictures mix beautifully. 

s File Edit Search Format Font Style 

iii!D Euolution of the Sonata-Allegro Form 

Chapter I 

Introduction 

In this paper I will discuss the Baroque epplicetions of the ritornello end 
the lete-Beroque ritornelloconcerto. I w ill then present 
late-nineteenth-century explenetions of the concerto form, di scuss how 
mos t of these theories feil under analysis, end conclude with a brief 
discussi on of Mozart's PitJno Concerto in C /"I/nor. K. 491, es a culmination 
of the synthesis of the ritornello principle and the developing 
sonata-allegro form. 

Definition of the Ritornello 

I 
Ritornello i s a compositional device rather than a form-a way to give 
cohesiveness to a work, not a detailed formal structure on which to 
compose.1 In this way it resembles a fugue. In the Baroque period it 
applied to short instrumental pa ssa es pla ed between opera scenes to 
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• MacPaint 

• MacTerminal 

MacPaint brings out the artist in everyone. Whether it 's a technical illustration 
for a research project or a sketch for a party announcement, you can do it with 
MacPaint. You can use MacPaint's drawing tools to draw perfectly structured 
shapes or your own freehand designs. You can type text in beautiful fonts, 
sizes, and styles and add text from other applications as well. 

Edit Goodies Font FontSize Style 

Label Concepts 
L tJbelfng Concepts for 

Sorenson's Jams and Jellies, In 
2 x Y gloss white labels 
Each label to be approved by client 

MacTerminal lets you communicate with the rest of the world. You can 
access information services such as THE souRCEsM, CompuServe® Information 
Services, or Dow Jones News/Retrieval®; exchange information with another 
computer; and send and receive electronic mai l. 
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• MacProject Project management and scheduling have never been easier. You tell 
MacProject what tasks are involved in your project and what resources you 
have. MacProject calculates the "critical path" to completion and estimates 
costs in money and time. If you miss (or beat!) a deadline or if your available 
resources change, MacProject recalculates everything in a flash . 

s File Edit Chart Task Layout Dates Fonts Style 

Move to new 
building 

Applications 

Manufacturing Relocation 

3/6 

Retissemble 
equipment 

3/6 

Refile 
ptipers 

4-.1.1 0/85 

Begin 
mBnufBcturing Bt 

new site 

John--You made the deadline! 
Keep up the good work and 
start thinking about the 
Operations move. 
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• MacDraw 

• Switcher 
Construction Kit 
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MacDraw lets you create structured graphics on the Macintosh 512K 
enhanced. You can prepare perfect flowcharts, diagrams, graphs, technical 
drawings, and organizational charts, as well as freehand drawings. You can add 
text in different fonts , sizes, and styles. 

s File Edit Style Font Layout Arrange Fill Lines Pen 

With the Switcher™ Construction Kit and the Macintosh 512K enhanced's 
512K of memory, you can work with up to four applications in memory at one 
time. You can construct '' integrated'' software customized just for the way you 
work, letting you switch among applications and exchange information as 
easily as you move papers on your desk. 
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• And Many More ... Top software developers are introducing many more applications for the 
Macintosh 512K enhanced. (Contact your authorized Apple dealer for 
availability.) You can choose from 

o electronic spreadsheets for budgeting, forecasting, and answering 
"What if?" questions 

o data base management programs for helping you keep track of everything 
from inventories to prospective clients to your favorite restaurants 

o charting programs for turning numbers nobody understands into charts 
everyone understands 

o programming languages, publishing programs, spelling checker programs, 
and hundreds more for getting your work done (and educational programs 
or games for when you need a break) 
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SOOK External Disk 
Drive 

138 

With an SOOK External Disk Drive attached to your Macintosh 512K enhanced, 
you can get at information on disks faster and make it easier to copy information 
from one disk to another. See "Disks" in Chapter 3. 
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Apple Hard Disk 20 The Apple Hard Disk 20 gives you 20 megabytes of disk space. With a hard disk 
you can keep all of your applications and documents in one place and get at 
them quickly. 
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Apple Talk 
Personal Network 

140 

The AppleTalk™ Personal Network is a low-cost local area network that's as 
easy to set up and use as your Macintosh 512Kenhanced. AppleTalk lets 
everyone in your work group communicate with each other (sending 
documents or electronic mail at 200 times the speed of ordinary 
telecommunications) . With AppleTalk you can also share the cost of high­
performance resources such as the LaserWriter-at a fraction of the cost of 
other networks. 
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Apple 
lmageWriter II 
Printer 

With an Apple Image Writer II printer attached to your Macintosh 512K 
enhanced, you can get high-quality printed copies at a low cost. And if you have 
another Apple computer, you can use the Image Writer II with it as well. 

If you have an Image Writer that's not an Image Writer II, you can purchase 
an adaptor kit that lets you use your printer with your Macintosh 512K 
enhanced. 
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Apple LaserWriter 
Printer 

1~2 

The Apple LaserWriter gives you near-typeset quality printed copies of your 
work, for a lot less money than you'd expect. And the LaserWriter uses the 
Apple Talk Personal Network so you can share the LaserWriter with the people 
you work with. 
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Apple Personal 
Modem 

An Apple modem lets your Macintosh 512K enhanced communicate with the 
rest of the world using telephone lines. You can send and receive messages 
through electronic mail, subscribe to news services, find out the latest price of 
your stocks, or access an entire university library from your Macintosh. 
Your Apple dealer can tell you about the Macintosh telecommunications 
possibilities, including MacTerminal. 

0 
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Keeping It in Good Shape 
Main Unit 
Keyboard 
Mouse 
Disks 
Clock Battery 

Service and Support 

If Something Goes Wrong 
The screen is dark. 
When you insert a disk, the screen is bright, but the desktop 
doesn't appear. 
A dialog box with a bomb icon appears. 
Moving the mouse has no effect on the pointer. 
Typing on the keyboard produces nothing on the screen. 
You can't save anything on a disk. 
You can't eject the disk. 
General Symptoms and Solutions 
Miscellaneous Software Problems 

Radio and Television Interference 
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Keeping It in Good 
Shape 

• MainUnit 

The first thing to know: You 'll never hurt your Macintosh 512K enhanced by 
clicking in the wrong place or pressing the wrong key. Your Macintosh 512K 
enhanced is no more fragile than a television set. And if you follow the few 
suggestions here , you and your Macintosh 512Kenhanced will be together for 
a long time. 

Give your Macintosh 512K enhanced plenty of space-enough so air can 
circulate on all sides, even the bottom. Make sure air can circulate around each 
of the ventilation slots on the top and sides of the main unit. Don't use it on 
thick-pile carpet or upholstery, and don't set anything on top of it while it 's 
switched on. You can store your Macintosh 512Kenhanced in a bookcase, but it 
shouldn't be crammed into a small space while you 're using it. 

Be careful not to spill liquids on your Macintosh 512K enhanced. The main 
unit is reasonably safe from small splashes, but probably won't survive a cup of 
coffee spilled into it. 

The Macintosh 512K enhanced can tolerate about the same range of 
temperatures as you can, but don't let it sit outside in direct sunlight or expose it 
to rain (much less hail, sleet, or snow). The top of the main unit will feel warm 
to the touch (about 85 ° -90 ° F) after it 's been on fora while. This is just the heat 
generated inside rising to the top and escaping. 

It's fine to keep your Macintosh 512K enhanced switched on even when you 're 
not using it. It uses very little electricity (about the same as a 60-watt light 
bulb), and it makes a fine night light. Just remember to turn down the 
brightness, because if your Macintosh 512K enhanced is left on for long 
periods (days or weeks), the image on the screen will start to "burn in ," and 
the screen may be permanently damaged. 

Never try to remove the cover from the main unit. The Macintosh 512K 
enhanced contains extremely high-voltage components that retain an 
electrical charge, even after the unit is switched off. 

Important Safety Instructions: The Macintosh 512Kenhanced is intended to be 
electrically grounded. It's equipped with a three-wire grounding-type plug, a 
plug having a third (grounding) pin. This plug will fit only into a grounding­
type AC outlet. This is a safety feature. If you are unable to insert the plug into 
the outlet, contact a licensed electrician to replace the outlet and, if necessary, 
install a grounding conductor. Do not defeat the purpose of the grounding-type 
plug. 
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• Keyboard 

• Mouse 
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The keyboard cable connectors are just like those used in modular telephones; 
however, the cables themselves are not. Never connect these cables to your 
telephone and never connect a phone cable to your Macintosh 512K 
enhanced. Doing so may cause permanent damage. 

Try not to spill anything on the keyboard. It can be ruined by a spilled soft 
drink or anything that leaves a sticky residue. If you spill something on the 
keyboard and it stops working: 

o If the liquid is sweet or sticky, unplug the keyboard and take it to your 
authorized Apple dealer for repair or replacement. 

o If the liquid is thin and clear, try unplugging the keyboard, turning it upside 
down to let the liquid drain out, and drying it for 24 hours at room 
temperature. If it still doesn't work, take it to your Apple dealer. 

Be careful not to drop the mouse or let it hang from a table by its cable. 
Just use common sense in treating it as carefully as you can. 

The surface your mouse moves on should be as smooth, clean, and dust-free 
as possible. And give the mouse itself an occasional cleaning. 

How to clean the mouse: 

1. Turn the mouse upside down and rotate the black plastic dial 
counterclockwise as far as it will go. 

2. Holding one hand over the ball and dial to catch them, turn the mouse back 
right side up. The dial and the ball will drop into your hand. 
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• Disks 

3. Inside the case are two plastic rollers , similar to those on a tape recorder. 
Using a cotton swab moistened with alcohol or tape head cleaner, gently 
wipe off any oil or dust that has collected on the rollers, rotating them to 
reach all surfaces. 

4. Wipe the ball with a soft, clean, dry cloth. (Don't use tissue or anything that 
may leave lint, and don't use a cleaning liquid.) 

5. Blow gently into the case to remove any dust that has collected there. 
6. Put the ball back into its case and, lining up the indicator on the dial with 

the '' 0' ' on the back of the case, reinsert the dial and turn it clockwise as far 
as it will go. (It will click when firmly in place.) 

Although Apple 3\12-inch disks are quite tough, they do have a few modest 
physical requirements-about the same as audio cassette tapes have. Your 
Macintosh disks should be kept dry, away from extreme temperatures (don't 
lay them on top of your Macintosh 512 K enhanced or store them on the seat of 
your car), out of direct sunlight, and out of reach of anything that contains a 
magnet, like a telephone. (Magnetic fields can scramble the information on 
the disk.) 

When the disk is inserted into the disk drive, the metal covering on the disk 
case slides to the left so the Macintosh 512K enhanced can get information 
from and save information on the disk. When the disk is out of the disk drive , 
the metal covering closes by spring action to protect the disk underneath it. 
Never touch the exposed disk under the metal covering. 
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Other than that, you don 't have to treat disks especially carefully. You can carry 
them around in your briefcase or coat pocket or mail them to your aunt in 
Cooperstown. (Two fit nicely in a business envelope.) 

0 

D 
10 ' C- 52 ' C ~ 

50 ' F-125 ' F ~ 

Be sure to make a copy of any disks you can't do without. (See "Copying an 
Entire Disk'' in Chapter 2.) It's no fun losing a report the night before you were 
going to make final corrections. 

You can purchase disks in a 10-pack from your authorized Apple dealer. 
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• Clock Battery Your Macintosh 512Kenhanced has a clock that runs continuously, even when 
the Macintosh 512K enhanced is switched off. (Choose Alarm Clock from the 
Apple menu to see it.) When the Macintosh 512K enhanced is off, the clock 
runs on battery power. The battery will probably last about two years. If the 
clock begins to lose accuracy, replace the battery. 

To do this, open the battery door on the back of the Macintosh 512K enhanced 
by pressing the latch, allowing the door to drop out. Replace the old battery 
with a new 4 .5-volt battery (Eveready No. 523 or equivalent) . Make sure you 
insert the battery so that its plus and minus indicators match those on the 
Macintosh 512Kenhanced cover. Put the battery cover back on. Reset the clock 
if you need to: choose Alarm Clock from the Apple menu. 
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To help you get the best performance from your Macintosh 512K enhanced 
system, Apple Computer, Inc., has established a worldwide network of full­
support Apple dealers. If you need answers to technical questions or 
information about product updates, your Apple dealer can help you . Apple's 
Technical Support organization backs each dealership to ensure prompt and 
reliable assistance . 

If service is required on your Macintosh 512K enhanced, take it to your 
authorized Apple dealer. Each authorized Apple dealer is required to employ 
Apple-trained service technicians and to use Apple parts in performing repairs . 
If you have moved, take your Macintosh 512K enhanced to the nearest 
authorized Apple dealer. There are more than 2,400 authorized Apple dealers 
in the United States alone. For the authorized Apple dealer nearest you in the 
United States, call (800) 538-9696; in Canada, (800) 268-7682. Or, if you 
prefer, write to: 

Apple Computer, Inc. 
Attn: Customer Relations 
29525 Mariani Avenue 
Cupertino, CA95014 

Apple also offers the AppleCareR Service Agreement, which keeps your 
warranty protection in force for up to three years. AppleCare is one of the 
lowest-priced service plans in the industry, and your AppleCare Agreement 
will be honored at all participating authorized Apple dealers within the country 
of purchase-an added benefit if you relocate. Local service means time saved 
in getting your Apple system back to work. 

You may purchase AppleCare at any time, but for uninterrupted protection, it's 
a good idea to buy the AppleCare along with your Macintosh 512K enhanced 
system. In addition to providing you with complete coverage, AppleCare 
purchased along with your Macintosh 512K enhanced avoids an owner-paid 
inspection of your system if your warranty has expired. Apple Care is available 
through your authorized Apple dealer. 
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If Something Goes 
Wrong 

Do not attempt to open the cover of your Macintosh 512K enhanced. The 
Macintosh 512Kenhanced was designed so that you never need to remove the 
cover of the main unit or the keyboard; everything you connect to your 
Macintosh 512K enhanced can be connected from the outside. If your 
Macintosh 512K enhanced stops working, try the suggestions that follow; if it 
still doesn't work, take it to your authorized Apple dealer. 

You may need to know the serial number of your Macintosh 512K enhanced. 
It's under the front edge of the Macintosh 512K enhanced. 

• The screen is dark. What's Probably Wrong 

• When you insert a 
disk, the screen is 
bright, but the 
desktop doesn't 
appear. 

The Macintosh 512K enhanced isn 't getting power or the brightness control is 
turned way down. 

What to Do 
Check the brightness control under the left side of the screen; turn it clockwise 
t{) make the screen brighter. Make sure the Macintosh 512K enhanced is 
switched on and the power cord is firm! y attached to both the main unit and the 
wall outlet. If the outlet is controlled by a wall switch, is the wall switch on? Is 
the outlet controlled by a dimmer switch? (Use a different outlet if it is.) 

What's Probably Wrong 
When you start up the Macintosh 512K enhanced or insert a disk, the Macintosh 
512K enhanced presents one of several icons that give you information about 
itself or the disk you inserted. Each icon gives you information about what's 
happening. 

0, ... I o I . .. I JI :·: :-: -. -· -. 
? x • 

What to Do 
The question mark means the Macintosh 512K enhanced is switched on and 
ready for you to insert a startup disk. 

The "happy Macintosh" means everything's fine to this point. 
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• A dialog box with 
a bomb icon 
appears. 

• Moving the mouse 
has no effect on the 
pointer. 

15-t 

An "X" usually means the disk you inserted to start up the Macintosh 512K 
enhanced isn't a startup disk. It can also mean the disk is damaged. Switch off 
the Macintosh 512 K enhanced and try restarting with a different disk. 

The "sad Macintosh" appears when the Macintosh 512K enhanced can't go 
any further because of a problem with the system software. Sometimes this 
indicates a hardware problem. See your dealer. 

You may have to eject the disk manually. To do this, press and hold the mouse 
button while you switch the Macintosh 512K enhanced off and then on again. 
(The groaning sound is normal.) 

What's Probably Wrong 
There's a serious problem with the software. 

What to Do 
The error codes presented in the dialog box are very general and may not be 
very helpful in discovering the problem. Try restarting the Macintosh 512K 
enhanced with the same disk. If the problem occurs again, abandon that disk 
and try a different version of the software. 

What's Probably Wrong 
The mouse might not be firmly connected to the main unit, or the mouse isn't 
working properly. There may be a problem with the software. 

What to Do 
Is the mouse firmly connected to the Macintosh 512K enhanced? Is it moving 
on a smooth, clean surface? Does the mouse need cleaning? (See "Keeping It 
in Good Shape" in this chapter.) 

If the problem doesn't seem to be with the mouse, check the software by first 
restarting the Macintosh 512K enhanced, then trying another disk. If there 
seems to be a software problem you can't solve by restarting or by trying 
another disk, tell your Apple dealer about it. Your dealer can get the answers 
you need . 
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• Typing on the 
keyboard 
produces nothing 
on the screen. 

• You can't save 
anything on a disk. 

• You can't eject the 
disk. 

What's Probably Wrong 
You might be in a situation that doesn't allow typing. (For example, MacPaint 
has a tool just for entering text.) The keyboard connection may be loose, or the 
keyboard broken. 

What to Do 
Make sure you're in a situation that allows typing. Use the Key Caps disk 
accessory to check each key. Make sure the keyboard is connected securely. 
If this doesn't help, see your Apple dealer. 

What's Probably Wrong 
Either the disk can't accept the information because it's full, not initialized for 
the Macintosh 512K enhanced, locked, or damaged, or the disk drive isn't 
working. 

What to Do 
Usually a message appears in a box describing the exact problem. If not, take 
the following steps. Eject the disk and see if the plastic tab is in the locked 
position. (If you can't eject it in the usual way, see the next section.) Reinsert 
the disk. Make sure the disk has been initialized for the Macintosh 512K 
enhanced. Check to see if there's room for more information on the disk by 
selecting the disk and choosing Get Info from the File menu. Try using a 
different disk. 

If you still have trouble saving anything, the disk drive probably isn't working 
correctly. Take the Macintosh 512K enhanced to your Apple dealer for help. 

What's Probably Wrong 
Your Macintosh 512K enhanced can't get the information it needs to eject the 
disk in the usual way. 

What to Do 
Press and hold the mouse button down while you switch the Macintosh 512K 
enhanced off and then on again. This should eject the disk. As a last resort, find 
the small hole beneath the disk drive. Insert a straightened paper clip or similar 
small object and push. This ejects the disk if all else fails. 
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If none of these specific symptoms or solutions seem to fit , consider the three 
general ways in which your Macintosh 512K enhanced could be ailing: 

o The application you're using could have gone wrong just this once after 
it was copied from the disk into memory. 

o The disk you' re using has bad information on it. 

o The Macintosh 512K enhanced is on the blink. 

If you've checked the specific symptoms in this chapter, and you still can't get 
any response from your Macintosh 512K enhanced, try turning it off briefly and 
then on again. If this works and this time you' re able to complete what you tried 
before, it was just a glitch. (That's a technical term.) If you find yourself in the 
same dilemma after restarting the Macintosh 512K enhanced, the problem is 
with the disk. Try another disk (one without any valuable documents on it, if 
possible, so you don't risk losing them). 

You can avoid many software problems by always keeping each of your startup 
disks current with the latest system software. See "Using the Installer" in 
Chapter 2. If you have the same problem with all disks, the Macintosh 512K 
enhanced most likely has a problem. Take it to your Apple dealer. 

Some applications may require their own customized system files to work 
properly. In this case, hold down the Option key while you open the 
application to force the Macintosh 512K enhanced to switch to another startup 
disk. This is especially useful if you're using a hard disk. See ''Startup Disks'' in 
Chapter 3. 

Some applications use data files such as help files kept together in a separate 
folder. If you drag that folder to a disk that's initialized two-sided, the 
application may not be able to find the data files. Try moving the data files to the 
same folder as the application. If all else fails , drag the application, document, 
any necessary data files , Finder, and System file together to the disk-level 
directory-not in any folder . 
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Radio and 
Television 
Interference 

The Macintosh 512 K enhanced generates and uses radio frequency energy. If it 
is not installed and used properly, that is, in strict accordance with our 
instructions, it may cause interference to radio and television reception. 

Your Macintosh 512K enhanced has been tested and complies with the limits 
for a Class B computing device in accordance with the specifications in Subpart 
] of Part 15 of FCC rules. These rules are designed to provide reasonable 
protection against such interference in a residential installation. However, 
there is no guarantee that the interference will not occur in a particular 
installation, especially if a "rabbit ear" TV antenna is used. (A "rabbit ear" 
antenna is the telescoping rod type usually contained on TV receivers.) 

You can determine whether your computer is causing interference by turning 
it off. If the interference stops, it was probably caused by the computer or its 
peripherals. To further isolate the problem: 

o Disconnect the peripheral devices and their I/0 cables one at a time. If the 
interference stops, it is caused by either the peripheral or its I/0 cable. 
These devices require shielded I/ 0 cables. Your Macintosh 512K enhanced 
and all Macintosh 512K enhanced peripherals come with shielded cables. 
For non-Apple peripherals, contact the manufacturer or dealer for 
assistance. 

o If you are using a non-Apple peripheral with your Macintosh 512K 
enhanced, be sure that it is supplied with a shielded I/O cable. The 
Macintosh 512Kenhanced has been tested with shielded cables and may not 
comply with the class B limits when used with nonshielded cables. 

If your computer does cause interference to radio or television reception, 
you can try to correct the interference by using one or more of the following 
measures: 

o Turn the TV or radio antenna until the interference stops. 

o Move the computer to one side or the other of the TV or radio. 

o Move the computer farther away from the TV or radio. 

o Plug the computer into an outlet that is on a different circuit from the TV or 
radio . (That is, make certain the computer and the TV or radio are on circuits 
controlled by different circuit breakers or fuses .) 

o Consider installing a rooftop TV antenna with coaxial cable lead-in between 
the antenna and TV. 

If necessary, you should consult your dealer or an experienced 
radio/ television technician for additional suggestions. 
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Holding down the Option key while you type another key on the keyboard 
produces the following characters (shown on the right side of each key) in the 
Chicago font. 

White = Character produced by holding clown the Option key while you type another 
character 

Red = Character produced by holding down the Option key and the Shift key while you 
type another character 

You produce accented characters by combining optional characters with 
standard characters. See "Keyboard" in Chapter 3. 

You can also view the optional character set by choosing the Key Caps desk 
accessory from the Apple menu. See ''Desk Accessories'' in Chapter 3. The Key 
Caps desk accessory lets you see the optional characters for all fonts in the 
current startup disk's System file. 
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AppendixB: 

Macintosh 512K 
enhanced 
Specifications 

Processor: 

Memory: 

Disk capacity: 

Screen: 

Interfaces: 

Sound generator: 

Input: 

Keyboard: 

Mouse: 

Clock/ calendar: 

AppendixB 

MC68000, 32-bit internal architecture, 7.8336 MHz 
clock frequency 

512KRAM 
128KROM 

SOOK per formatted double-sided disk, 3Yi-inch-
diameter hard-shell media 

9-inch diagonal , high-resolution, 
512-pixel by 342-pixel bit-mapped display 

Synchronous serial keyboard bus 
Two RS232/ RS422 serial ports, 230.4K baud maximum 

(up to 0.920 megabit per second if clocked 
externally) 

Mouse interface 
External disk interface 

4-voice sound with 8-bit digital-analog conversion 
using 22 KHz sample rate 

Line voltage: 105 to 125 volts AC, RMS 
Frequency: 50 or 60 Hz 
Power: 60 watts 

58 key, 2-key rollover, software mapped, detachable 

Mechanical tracking, optical shaft encoding 3.54 pulse 
per mm (90 pulse per inch) of travel 

CMOS custom chip with 4 .5 volt (Eveready No. 523 or 
equivalent) user-replaceable battery backup 
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Size and weight: 

Environment: 
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Weight Height Width 

Main Unit 7.5 kg 344mm 246mm 
(16lb8oz) (13.5 in) (9.7 in) 

Keyboard 1.2 kg 65mm 336mm 
(2 lb 8.5 oz) (2.6 in) (13.2 in) 

Mouse .2kg 37mm 60mm 
(7 oz) (1.5 in) (2.4 in) 

Temperature: operating: 10 ° C to 40 ° C 
(50° F to 104 ° F) 

storing: -40° C to 50° C 

Depth 

276mm 
(10.9 in) 

146mm 
(5.8 in) 

109mm 
(4.3 in) 

(-40° Fto122° F) 

Humidity, all conditions: 5% to 90% relative humidity 

Altitude: 0 to 4615 m ( 0 to 15 ,000 ft) 



AppendixC: 

Application 
Development for 
the Macintosh 
512K enhanced 

If you want to develop new applications for the Macintosh 512K enhanced, ask 
your Apple dealer about Inside Macintosh, the technical documentation. Or 
write to: 

Apple Developer Relations 
Mailstop 23-AW 
Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, CA 95014 

A programmer's switch is included with the Macintosh 512K enhanced. Install 
it only if you 're developing stand-alone applications or desk accessories. The 
switch has two parts. The front part of the switch is a reset switch. Pressing it is 
just like pressing the power switch off and carries the same cautions-press it 
only in the Finder with all disks properly ejected. The back part of the switch is 
an interrupt switch; press it only if you have debugging software installed. 

The switch snaps into place on the left side of the Macintosh 512K enhanced, 
toward the back, in the second slot from the bottom. 
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Macintosh 512K 
enhanced Cables 
for Peripheral 
Devices 
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ImageWriter II IQJ M01 85 
( Circular-8) Macintosh Peripheral -8 Cable 

Image Writer 
(DB·25) l•<-"·""'""1•1 

Use existing cable 

Apple Personal Modem IQJ l\10185 
(Circular-8) Macintosh Peripheral -8 Cable 

Apple Modem Use existing cable 
300/1200 l•=•I 
(DB-9) 

AppleTalk 1°= 0 1 l\12010 
(DB-9) AppleTalk Connector Kit 

The Macintosh 512K enhanced was FCC certified under test conditions that 
include the use of shielded cables and connectors between system components. 
It is important that you use shielded cables and connectors to reduce the 
possibility of causing interference to radio, television, and other electronic 
devices. 
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C losebox:--------+--~~~~~~~~~iiiiiiiigj] 
Active window's title bar---+-8---e---.../ 
Zoombox-------+-~::::::::::::::::::::::::::::::::::::::::::::::::::::::~"=='i61 
Directory window-----+~ 
Application icon------+--- -..../ , 
I-beam pointer ------+-4 -_;,,:.:..;;,:...:..:..:.... _ __, 
Document icon, selected---+--++----,=-----./ 
Selected text------+-~--1--4-----_/ 
Folder icon--------1--W-____.....i& 
Scroll bar-------+---#l:;:o:n=========,,r-.r...~ 
scroll box:-------+-t=:::==!Z:!!;;::::::=:=:=n~r 
Scroll arrow-------+-+-......,.,;.;;_..., 
Size box --------1---l~'---w;i 
Disk icon-------+-t---....... -""'~-..;;;...-,,.:;;rll;:_...;;;.:::;;..._.,,.::ii:::=;./ 
Trash --------+-E--""'!""_;;;..~..,....--......: 
Desktop --------+....;;.-

Work Startup Dis 
Dialog box--------l--1 

Please name this disk: 

Insertion point------+-ttr-------:===£_ 
OK 

Button--------rt!;::::;:;;:::::::::::;;:::::::::::;;::::::::::~;,,,,,;:;;;;::;:;;:;:;;======:::!J 
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[ Caps Lock 
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active window 
The frontmost window on the desktop; the window where the next action will 
take place. An active window's title bar is highlighted. 

Alarm Clock 
A desk accessory that displays the current date and time. 

Apple menu 
The menu on the far left in the menu bar. Its title is an apple symbol. 

application program 
A tool to manipulate information, sometimes called an ''application.'' 

Backspace key 
A key that moves the insertion point backward, removing the previously typed 
character, or that removes the current selection. 

button 
The places in dialog boxes where you click to designate, confirm, or cancel 
an action. See also mouse button. 

Calculator 
A desk accessory that works like a four-function pocket calculator. You can cut 
and paste calculation results into your documents. 

Cancel button 
A button that appears in dialog boxes. Clicking this button cancels the 
command. 

Caps Lock key 
A key that, when engaged, causes subsequently typed letters to appear 
in uppercase. It works like a Shift key except that it doesn't affect numbers 
or symbols. 

character keys 
The following keys on the Macintosh 512K enhanced keyboard-letters, 
numbers, symbols, punctuation, Return, Tab, and the space bar. 

check box 
The small box or circle associated with an option in a dialog box that, when 
clicked, adds or removes the option. 

choose 
To pick a command from a menu by dragging. Usually you do this after you've 
selected something for the Macintosh 512K enhanced to act on. 
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Chooser 
A desk accessory that lets you configure your Macintosh 512K enhanced 
system to print on any printer for which there's a printing resource on the 
current startup disk and lets you designate the port you've physically 
connected the printer to. You can also specify a user name that the Macintosh 
512Kenhanced may use from time to time-when you're printing on a 
LaserWriter, for example. 

click 
To position the pointer on something, then press and quickly release the 
mouse button. 

Clipboard 
The holding place for what you last cut or copied. 

close 
To turn a window back into the icon that represents it. 

close box 
The small white box on the far left side in the title bar of an active window. 
Clicking a close box closes the window. 

command 
A word or phrase, usually in a menu, describing an action for the Macintosh 
512K enhanced to perform. Also, a combination of the Command key and a 
character key that accomplishes the same thing. 

Command key 
A key that, when held down while another key is pressed or a mouse action 
is performed, causes a command to take effect. 

Control Panel 
A desk accessory that lets you change the speaker volume, the Apple Talk 
connection, create a RAM cache , and set other preferences. 

current startup disk 
The startup disk whose system files the Macintosh 512K enhanced is currently 
using. See also startup disk. 

cut 
To remove something by selecting it and choosing Cut from the Edit menu. 
What you cut is placed on the Clipboard. 

desk accessories 
"Mini-applications" that are available on the desktop from the Apple menu 
regardless of which application you're using. Examples are the Calculator, 
Alarm Clock, and Scrapbook. 
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desktop 
Macintosh's working environment-the menu bar and the gray area on the 
screen. 

dialog box 
A box containing a message requesting more information from you. 
Sometimes the message is a warning that you 're asking your Macintosh 512K 
enhanced to do something it can't do or that you' re about to destroy some of 
your information. In these cases the message is often accompanied by a 
"beep." 

dimmed command 
A command that appears dimmed compared to other commands in the menu. 
A dimmed command can't be chosen. 

dimmed icon 
An icon that represents a disk that has been ejected, or a document, folder, or 
application on a disk that has been ejected. Dimmed disk or folder icons can be 
selected and opened, but the documents and applications on them can't be 
opened. 

directory 
A pictorial, alphabetical, or chronological list of the contents of a folder or 
a disk. 

disk 
The magnetic medium on which the Macintosh 512Kenhanced stores 
information. The Macintosh 512K enhanced can use a 3 Yi-inch disk or a hard 
disk. 

disk drive 
The mechanism that holds the disk, retrieves information from it, and saves 
information on it. A hard disk drive has the disk permanently encased. A 3 Yi­
inch disk drive requires that you insert a 3 Yi-inch disk. 

document 
Whatever you create with Macintosh applications-information you enter, 
modify, view, or save. 

double-click 
To position the pointer where you want an action to take place, and then press 
and release the mouse button twice in quick succession without moving the 
mouse. 
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drag 
To position the pointer on something, press and hold the mouse button, move 
the mouse and release the mouse button. When you release the mouse button, 
you either confirm a selection or move an object to a new location. 

Enter key 
A key that confirms or terminates an entry or sometimes a command. 

file 
A collection of information stored on a disk-a document, a system file like 
the System file or Finder, an application, and so forth. 

Finder 
An application that's always available on the desktop. You use it to manage 
documents and applications, and to get information to and from disks. 

folder 
A holder of documents, applications, or other folders on the desktop. 
Folders allow you to organize information in any way you want. 

font 
A collection of letters, numbers, punctuation marks, and other typographical 
symbols with a consistent appearance. An example of a Macintosh font is 
Geneva. 

hard disk 
A disk drive that has the disk permanently encased. See also disk drive. 

hardware 
Anything about the Macintosh 512K enhanced that you can see or touch. 

hierarchical file system 
A way of using folders to organize documents, applications, and other folders 
on a disk to keep together and view related information. Folders (analogous 
to subdirectories in other systems) can be nested in other folders to create 
as many levels of a hierarchy as you need. Opening a folder presents only 
the information you've put in that folder, so you can concentrate on that 
information without viewing everything on the disk. 

highlight 
To make something visually distinct from its background, usually to show that 
it has been selected or chosen. 

I-beam 
A type of pointer used in entering and editing text. 
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icon 
A graphic representation of an object, a concept, or a message. Icons are often 
objects associated with the Finder. 

information window 
The window that appears when you select an icon and choose Get Info from 
the File menu. It supplies information such as size, type, and date, and it 
includes a place for adding notes. 

initialize 
To prepare a disk to receive information. SOOK disks you use with the 
Macintosh 512K enhanced can be initialized on both sides or on just one side. 

insertion point 
The spot in a document where something will be added. An insertion point 
is selected by clicking and is represented by a blinking vertical bar. 

lock 
To prevent documents from being edited, discarded, or renamed, or to prevent 
entire disks from being altered. 

main unit 
The Macintosh 512K enhanced console, which contains the processor, 
memory, the built-in disk drive, and the screen. 

memory 
The place in the Macintosh 512K enhanced main unit that stores information 
whileyou'reworkingwithit. The Macintosh 512Kenhancedincludes 512Kof 
memory you can use for your work, and 128K of ROM (read-only memory) 
that stores certain system information permanently. See also RAM and ROM. 

menu 
A list of commands that appears when you point to and press the menu title in 
the menu bar. Dragging through the menu and releasing the mouse button 
while a command is highlighted chooses that command. 

menu bar 
The horizontal strip at the top of the screen that contains menu titles. 

menu title 
A word or phrase in the menu bar that designates one menu. Pressing on the 
menu title causes the title to be highlighted and its menu to appear below it. 

mouse 
The small device you roll around on a flat surface next to your Macintosh 512K 
enhanced. When you move the mouse, the pointer on the screen moves 
correspondingly. 
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mouse button 
The button on the top of the mouse. In general, pressing the mouse button 
initiates some action on whatever is under the pointer, and releasing the button 
confirms the action. 

numeric keys 
Keys on the right of the keyboard that let you do numeric entry and calculation 
quickly. 

open 
To create a window from an icon so you can view a document or directory. 

Option key 
A key used like the Shift key to give an alternate interpretation to another key 
you type. You use it to type foreign characters or special symbols. 

paste 
To put a copy of the contents of the Clipboard-whatever was last cut or 
copied-at the insertion point. 

pointer 
A small shape on the screen, most often an arrow pointing up and to the left, 
that follows the movement of the mouse. 

press 
To position the pointer on something and then hold down the mouse button 
without moving the mouse. 

printing resource 
A system file that lets you print on a corresponding printer attached to the 
Macintosh 512K enhanced. Sometimes called a "printer driver." 

RAM 
Random access memory, the part of the Macintosh 512K enhanced memory 
that stores information temporarily while you' re working on it. RAM can 
contain both application programs and your own information. Information in 
RAM is temporary, gone forever if you switch the power off. An exception to 
this is a small amount of memory used to save settings, such as the clock and 
Speaker Volume, that's powered by battery when your Macintosh 512K 
enhanced is switched off. 

RAM cache 
RAM you can designate to store certain information an application uses 
repeatedly. Using the RAM cache can greatly speed your work, but may need to 
be used sparingly or not at all with applications that require large amounts of 
memory. You set the RAM cache in the Control Panel. 
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Return key 
A key that causes the insertion point to move to the beginning of the next line. 
It's sometimes used to confirm or terminate an entry or a command. 

ROM 
Read-only memory, the part of memory that contains information the 
Macintosh 512K enhanced uses (along with system files) throughout the 
system, including the information it needs to get itself started. Information in 
ROM is permanent; it doesn't vanish when you switch the power off. The 
Macintosh 512Kenhanced contains 128Kof ROM. See also RAM. 

save 
To store information on a disk. 

Scrapbook 
A desk accessory in which you save frequently used pictures and text. 

scroll 
To move a document or directory in its window so that you can see a different 
part of it. You can also scroll the directory in some dialog boxes. 

scroll arrow 
An arrow on either end of a scroll bar. Clicking a scroll arrow moves the 
document or directory one line. Pressing a scroll arrow scrolls the document 
continuously. 

scroll bar 
A rectangular bar that may be along the right or bottom of a window. Clicking 
or dragging in the scroll bar causes the view of the document to change. 

scroll box 
The white box in a scroll bar. The position of the scroll box in the scroll bar 
indicates the position of what's in the window relative to the entire document. 

select 
To designate where the next action will take place. To select, you click or drag 
across information. 

selection 
The information affected by the next command. The selection is usually 
highlighted. The insertion point is also a selection. 
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Shift-click 
A technique that allows you to extend or shorten a selection by holding down 
the Shift key while you select (or deselect) something related to the current 
selection. 

Shift key 
A key that, when pressed, causes subsequently typed letters to appear in 
uppercase and causes the upper symbol to appear when number or symbol 
keys are typed. 

size box 
A box on the bottom-right corner of some active windows that lets you resize 
the window. 

software 
Programs, or instructions for the Macintosh 512K enhanced to carry out. The 
Macintosh 512K enhanced reads these instructions from disks inserted into the 
disk drive. 

startup disk 
A disk that contains the system files the Macintosh 512K enhanced needs to get 
itself started. A startup disk must have at least a Finder and a System file. It may 
also contain files such as printing resources, Scrapbook, and Clipboard. 

style 
A stylistic variation of a font, such as italic, underline, shadow, or outline. 

system file 
A file the Macintosh 512K enhanced uses to start itself up or to provide system­
wide information. Although system files are represented by icons just as 
documents and applications are, they can't be opened in the usual way. You 
can, however, alter the contents of system files. For example, you can use the 
Font/DA Mover to change the contents of the System file or change the 
contents of the Scrapbook or Note Pad files by using those desk accessories. 
See also startup disk. 

Tab key 
A key that, when pressed, moves the insertion point to the next tab marker or, 
in a dialog box with more than one place to enter information, to the next 
rectangle. 

title bar 
The horizontal bar at the top of a window that shows the name of the window's 
contents and lets you move the window. 
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utility program 
A special-purpose application that usually alters a system file. Examples are the 
Font/DA Mover and the Installer. 

window 
The area that displays information on the desktop. You view documents 
through a window. You can open or close a window, move it around on the 
desktop, and sometimes change its size, edit its contents, and scroll through it. 

~~~0~ zoom box 
The small box on the right side of the title bar of some windows. Clicking the 
zoom box expands a window to its maximum size. Clicking it again returns the 
window to its original size. 
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Index 

400K 
disk drive 98-99 
disks. See single-sided disks 

SOOK 

A 

disk drive 93, 98-99, 138 
disks. See double-sided disks 

About the Finder command 24, 86, 120 
accented characters 96 
activating windows 16-18, 44 
activewindow 16-18 

printing 71 , 128 
adjusting brightness control 5 
Alarm Clock 36-37, 108-109 

battery 151 
alert messages 25, 107 

See also beeps 
AppleCare Service Agreement 152 
Apple menu 84 , 108-1 13, 120 

About the Finder command and 24, 86, 120 
Alarm Clock and 36-37, 108-109, 151 
Calculator and 109 
Chooser and 52, 77, 109-110 
Control Panel and 53, 75, 110 
Key Caps and 110-111 
Note Pad and 84, 112 
Puzzle and 84, 113 
Scrapbook and 56-57, 113 

AppleTalk ImageWriter II 
cables for 164 
Chooser and 110 

AppleTalk Personal Network 140 
cables for 164 
Chooser and 52 
Control Panel and 53 
Installer and 87 

Index 

application(s) 23-30, 93, 115 
copying 65-67 
creating documents in 74 
desktop and 33 
development of 163 
icon 27 
initializing disks from 99 
Installer and 86-87 
locking 69 
naming 101 
opening documents in 74-75 
printing documents in 77 
problems with 154 
recovering 68 
removing 68 
renaming 64 
saving documents in 76-77 
See also specific application 

arranging 
desktop 8-10 
disks 104 

B 
Backspace key 26, 49, 97, 127 
backup copies. See copying 
battery, Alarm Clock 153 
beeps 25, 70, 107, 109 

speaker volume and 53 
See also alert messages 

blinking 
menu bar 53, 109 
question mark 4, 153 
vertical bar. See insertion point 

bomb icon 154 
booting. See starting 
brightness control 5, 153 
By Date command 125 
By Icon command 125 
By Kind command 125 
By Name command 36, 125 
By Size command 125 
By Small Icon command 124 

c 
cables 164 
Calculator 109 
Caps Lock key 95 

KeyCapsand 110-111 

175 



Caps Lock-Command-Shift-4 71, 128 
care 

Alarm Clock 151 
disk 149- 151 
keyboard 148 
main unit 147 
mouse 148-149 

changing 
Delay until Repeat 55 
desktop pattern 53 
double-clicking speed 54 
insertion point blinking 54 
keyboard repeat rate 55 
speaker volume 53 
view 36 
window size 14- 15, 45 

Chooser 52, 77, 109-110 
choosing 11-13 
Circular-8 connector 164 
Clean Up command 125 
Clear command 49, 124 
clicking 8-9, 42 

See also double-clicking; Shift-clicking 
Clipboard 29-30, 106 
Clipboard file 106 
clock. See Alarm Clock 
close box 13, 15, 20-21 , 45, 127 
Close command 20, 45 , 121 
Command key 96, 128 

moving windows with 44 
Command-E 81 , 128 
Command-period(.) 96, 128 
Command-Shift-I 128 
Command-Shift-2 128 
Command-Shift-3 70, 128 
Command-Shift-4 71, 128 
command(s) 

choosing 11-13 
dimmed 12 
highlighted 12 
keyboard. See Command key 
See also specific command 

comments 27-28 
communications. See MacTerminal; modems 
connectors 164 
Control Panel 53-55, 75, 110 
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Copy command 29, 30, 49, 106, 123 
Scrapbook and 56, 57 

copying 
applications 65-67 
disks 83 
documents 65-67 
folders 65 -67 
text 49 
to folders 63 
See also Copy command; Paste command 

copy protecting. See locking 
creating 

documents 23-25, 60, 74 
folders 62 
MacPaint documents from screen 70, 128 
snapshots 70, 128 
startup disks 82 

current startup disk 103 
cursor. See pointer 
cursor keys. See direction keys 
customizing startup disks 84 -85, 102 
Cut command 28-30, 49, 106, 123 

Scrapbook and 56, 57 

D 
DB-9 connector 164 
DB-25 connector 164 
Delay until Repeat 75 

changing 55 
deleting. See Backspace key; Clear command; Cut command; 

Erase Disk command; removing 
desk accessories 51-5 7, 108-113 

Alarm Clock 36-37, 108-109, 151 
Calculator 109 
Chooser 52 , 77, 109-110 
Control Panel 53-55, 75, 110 
Font/ DA Mover and 84-85 
Key Caps 110-11 1 
Note Pad 84, 112 
Puzzle 84, 113 
Scrapbook 56-57, 113 

desktop 6, 117 
applications and 33 
arranging 8-10 
documents and 33 
pattern, changing 53 

development of applications 163 
device resources , Chooser and 52 
devices, peripheral. See specific device 



diacritical marks 96 
dialog boxes 25-26, 107, 127 
dimmed 

commands 12 
icons 24 

directorywindow 12-13 
See also folder(s) 

disk(s) 93, 98-104, 115 
arranging 104 
caring for 149-150 
copying 83 
directory, printing 71 
double-sided 80, 98-99 
ejecting 81, 154, 155 
folders and 26 
initializing 80, 98-99, 128 
locking 100 
naming 101 
problems with 155 
single-sided 75, 77, 80, 87, 98-99, 128 
startup 23, 82, 86-87, 102-103 
updating 86-87 

disk drives 93, 98-99, 138 
Hard Disk 20 and 87, 139 

documents 3, 115 
copying 65-67 
creating 23-25, 60, 74 
desktop and 33 
folders and 33 
locking 69 
naming 101 
opening 61, 74-75 
organizing 31-37 
printing 70, 77 
recovering 68 
removing 68 
renaming 64 
saving 25-27, 76-77, 94 
selecting by typing 75 
See also text 

double-clicking 19-20, 42, 43, 127 
changing speed of 54 
See also clicking; Shift-clicking 

double-sided disks 98-99 
initializing 80 

Index 

dragging 42, 43 
icons 9-10, 118-119 
windows 15-16 
See also selecting 

Drive button 75, 77 
Duplicate command 65, 122 

E 
Edit menu 123-124 

Clear command and 49, 124 
Copy command and 29, 49, 56, 57, 106, 123 
Cut command and 28-30, 49, 56, 57, 106, 123 
New Folder command and 31-32 
Paste command and 30, 49, 56, 57, 106, 124 
Select All command and 47, 68, 124 
Show Clipboard command and 30, 106, 124 
Undo command and 123 

editing text 27-30, 48-49 
SOOK disks. See double-sided disks 
Eject button 75, 77 
Eject command 81 , 123 
ejecting disks 81, 154, 155 
empty folders 31-32 
Empty Trash command 68, 125 
Enter key 97, 127 
Erase Disk command 80, 99, 126 
erasing. See Backspace key; Clear command; Cut command; 

Erase Disk command; removing 
error messages. See alert messages 

F 
file (s) . See documents; System Folder 
File menu 120-123 

Close command and 20, 45, 121 
Duplicate command and 65, 122 
Eject command and 81, 123 
Get Info command and 27-28, 35, 69, 122 
New command and 74 
New Folder command and 62, 121 
Open command and 12,60,61, 74, 121, 127, 128 
Page Setup command and 71, 77, 122 
Print Catalog command and 71, 122 
Print command and 70, 77, 109, 121 
Put Away command and 68, 122 
Save As command and 76-77, 127, 128 
Save command and 25-26, 76-77 
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filing. See folder(s) 
Finder 23-24, 59, 114-115 

About the Finder command and 24 
Chooser and 52 
menus. See specific menu 
MiniFinder and 72-73 
shortcuts 129 

folder(s) 26,31-33,62-63, 74-75, 117 
copying 65-67 
copying to 63 
creating 62 
directory, printing 71 
documents and 33 
empty 31-32 
hierarchy of 62 
naming 101 
nesting 62 
recovering 68 
removing 68 
renaming 64 
saving to 76-77 
selecting by typing 75 
single-sided disks and 75, 77, 128 
System 19, 23, 31, 82, 86 
Utilities 20 

Font menu 84 
Font/DA Mover 84-85 
formatting. See initializing 
400K disks. See single-sided disks 

G 
Get Info command 27-28, 69, 122 

multiple windows and 35 
graphics tablet, setting Control Panel for 54 

H 
"happy Macintosh" icon 153 
Hard Disk 20 139 

Installer and 87 
hardware 93 
hierarchical file system. See folder(s) 
highlighted 

commands 12 
icons 8 
menus 12 
title bar 17 
See also selecting 

hollow icons 12 
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I, J 
I-beam 7 
icon(s) 4 

application 27 
dimmed 24 
dragging 9-10, 118-119 
highlighted 8 
hollow 12 
opening 19-20 
renaming 32 
selecting 8-9, 33-35, 47, 118 

ImageWriter 77, 141 
cables for 164 
Chooser and 52, 109-110 

ImageWriter II 141 
AppleTalk option and 110, 164 
cables for 164 
Chooser and 110 

information window. See Get Info command 
initializing disks 80, 98-99, 128 
inserting text 48 
insertion point 26, 48 

blinking, changing speed of 54 
Installer 86-87 
interference 15 7 

K 
keyboard 26, 93, 95-97 

attaching 4 
caring for 150 
commands. See Command key 
optional character set and 96, 160 
problems with 86, 155 
repeat rate, changing 55 
See also specific key 

Key Caps 110-111 

L 
LaserWriter 14 2 

cables for 164 
Chooser and 52, 110 

locking 
applications 69 
disks 100 
documents 69 



M 
MacDraw 136 
MacPaint 134 

documents, creating from screen 70, 128 
MacProject 135 
MacTerminal 134 
MacWrite 133 
main unit 93 

caring for 147 
memory 93 
menu bar 11 

blinking 53, 109 
menus 11 -13 

See also specific menu 
MiniFinder 72-73 
Modem port. See Chooser 
modems 143 

cables for 164 
mouse 7-10,42-43,93 

attaching 4 
caring for 148-149 
problems with 154 
setting Control Panel for 54 

moving 
applications, to different disk 66-67 
documents, to different disk 66-67 
folders, to different disk 66-67 
text 49 
to folders 63 
windows 15-16, 44 
See also Copy command; Cut command; Paste command 

N 
naming 101 

See also renaming 
nesting fo lders 62 
New command 74 
New Foldercommand 31-32,62, 121 
Note Pad 84, 112 
Note Pad file 11 2 

0 
one-sided format 80, 98-99, 128 
Open command 12, 60, 61, 74, 121 

selecting by typing and 128 
Tab key and 127 

Index 

opening 
documents 61, 74-75 
icons 19-20 

Option key 96, 128, 160 
Key Caps and 110-111 

Option-' 96 
Option-e 96 
Option-i 96 
Option-n 96 
Option-u 96 
optional character set 96, 160 
organizing documents 31-37 

p 
padlock 69 

See also locking 
Page Setup command 71 , 77, 122 
Paste command 30, 49, 106, 124 

Scrapbook and 56, 57 
peripheral devices. See specific device 
Personal Modem 143 

cables for 164 
plastic piece 4 
pointer 7 

problems with 154 
port(s) 

Printer 52, 77, 109 
See also Chooser 

power cord, attaching 4 
pressing 42 
Print Catalog command 71 , 122 
Print command 70, 77, 109, 121 
Printer port 52, 77, 109 
printer(s). See AppleTalk ImageWriter II ; ImageWriter; 

ImageWriter II ; LaserWriter 
printing 70-71, 77, 128 
printing resources 

Chooser and 52 
Installer and 86-87 

problems 153- 156 
processor 93 
programmer's switch 113, 163 
program(s). See application(s) or specific application 
pull -down list 75 
Put Away command 68, 122 
Puzzle 84, 11 3 
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a 
question mark, blinking 4, 153 

R 
radio interference 157 
RAM cache, setting Control Panel for 54 
recovering 68 
removing 

applications 68 
documents 68 
folders 68 
text 49 
See also Backspace key; Clear command; Cut command; 

Erase Disk command 
renaming 

applications 64 
documents 64 
folders 64 
icons 32 
See also naming 

replacing text 49 
retrieving. See opening 
Return key 97, 127 

s 
"sad Macintosh" icon 154 
Save As command 7 6-77 

selecting by typing and 128 
Tab key and 127 

Save command 25-26, 76-77 
saving 

documents 25-27, 76-77, 94 
to folders 76-77 

Scrapbook 56-57,113 
Scrapbook file 56, 113 
screen 93 

creating MacPaint documents from 70, 128 
dumps 70, 128 
printing 71, 128 
problems with 153-154 

scroll arrows 22, 46 
scroll bars 13, 21-22, 46 
scroll box 46 
scrolling 46 
Select All command 4 7, 68, 124 
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selecting 
by typing 75, 128 
icons 8-9, 47, 118 
multiple icons 33-35, 47 
text 28-29, 48 
See also clicking; double-clicking; dragging; Shift-clicking 

serial number 153 
service 152 
Set Startup command 126 
Shift key 26, 95 

Key Caps and 110-111 
Shift-clicking 35, 47, 127, 42, 43 

See also clicking; double-clicking 
shortcuts 127-129 
Show Clipboard command 30, 106, 124 
Shut Down command 81, 126 
single-sided disks 98-99 

folders and 75, 77, 128 
initializing 80 
Installer and 87 

size box 13, 14,45 
snapshots, creating 70, 128 
software. See application (s) or specific application 
speaker volume, changing 53 
Special menu 125-126 

Clean Up command and 125 
Empty Trash command and 68, 125 
Erase Disk command and 80, 99, 126 
Set Startup command and 126 
Shut Down command and 81, 126 
Use MiniFinder command and 72, 126 

specifications 161-162 
starting 4-6 

problems with 153-154 
startup disks 23, 102-103 

creating 82 
current 103 
customizing 102 
Installer and 86-87 

Switcher Construction Kit 136 
system 

hardware 93 
software. See startup disks; System Folder 

System file 84-85 , 102 
system files 19, 82, 86-87, 102 
System Folder 19, 23, 31 , 82, 86 
System Tools disk 23 



T 
Tab key 75, 77, 97, 127 
television interference 15 7 
text 

copying 49 
editing 27-30, 48-49 
inserting 48 
moving 49 
removing 49 
replacing 49 
selecting 28-29, 48 
See also Cut command; documents; Paste command 

time. See Alarm Clock 
title bar 13 

highlighted 17 
Trash kon 67,68,81, 118 

Empty Trash command and 68, 125 
Trash window 68 
troubleshooting 153-156 
two-sided format 80, 98-99, 128 
typing, selecting by 75, 128 

u 
Undo command 123 
updating disks 86-87 
Use Mini Finder command 72, 126 
username 52 
Utilities Folder 20 
utility applications 20 

v 

Font/ DA Mover 84-85 
Installer 86-87 

View menu 124-125 
By Date command and 125 
By Icon command and 125 
By Kind command and 125 
By Name command and 36, 125 
By Size command and 125 
By Small Icon command and 124 

Index 

w 
warning messages. See alert messages 
window(s) 14-22,44-45, 105 

activating 16-18, 44 
acti ve 16-18, 71, 128 
changing size of 14-15, 4 5 
close box and 13, 15 ,20-2 1, 45, 127 
directory 12-13 
dragging 15-16 
information. See Get Info command 
moving 15-16,44 
scroll arrows and 22, 46 
scroll bars and 13, 21-22, 46 
scroll box and 46 
size box and 13, 14, 45 
title bar and 13 , 17 
zoom box and 13, 14-15 , 45, 127 
See also specific window 

wristwatch 7 

x,v 
"X" icon 154 

z 
zoom box 13, 14-15, 45, 127 
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&Tell Apple About Your Macintosh™ 512K enhanced 

• Would you like to tell Apple what you think about this product? After you have had an opportunity to use 
this product we would like to hear from you. You can help us to improve our manuals by responding to 
the questionnaire below and marking the appropriate boxes on the card at the right with a #2 lead 
pencil. If you have more than one response to a question, mark all the boxes that apply. Please detach the 
card and mail it to Apple. 

• Please contact your authorized Apple dealer when you have questions about your Apple products. 
Dealers are trained by Apple Computer and are given the resources to handle service and support for 
all Apple products. If you need the name of an authorized Apple dealer in your area, call toll-free: 
800-538-9696. 

1. What is your overall rating of this Apple Product? (1=low ... S=high) 

2. How long have you been using your Apple Computer? (1=under1month,2=6 months, 3=over 6 months) 

3. Where did you purchase your Apple Computer? ( 1=Dealer,2 =Consortium, 3= Corp. Buy, 4= Teacher Buy, 
5 = Department Store, 6 =other) 

4. Did you own an Apple computer before buying your new Apple computer? (1=yes,2= no) 

5. How much prior experience have you had using computers? (1=none, 2=little, 3=moderate, 4=extensive) 

6. Where is your computerused most often? ( 1 =home, 2 =work, 3= school, 4= other) 

7. Who uses the computer? (1=male adult, 2=female adult, 3=male child, 4=female child) 

8. What software applications will you be using most often with your Apple computer? (1 =word processor, 
2= spreadsheet, 3= data base, 4= communication, 5 =games, 6 =education, 7 =graphics, 8 =other) 

9. Which storage devices do you use with your computer? ( 1= Macintosh400K, 2 =Macintosh BOOK, 3= Hard Disk 20, 
4=other) 

10. What printer do you use with your computer? (1 =Image Writer II, 2= Image Writer, 3= LaserWriter, 
4=other dot matrix printer, S=other daisy wheel printer) 

11. Which other products do you use with your computer? ( 1 = plotter, 2 = AppleTalk, 3 =modem, 4= numeric keypad, 
S=other) 

12. How easy was your computer to set up? ( 1 =difficult . . . 5 =easy) 

13. Did you use the manual to help you set up? (1=yes, 2=no) 

14. How would you rate the product training materials? (1=low ... S=high) 

15. How helpful was the training in learning how to use your computer? (1 = not helpful ... S=very helpful) 

16. How would you rate the manual? (1=low ... S=high) 

17. How easy was the manual to read and understand? ( 1 =difficult ... 5 =easy) 

18. Which section of the manual do you use most? 

19. Please describe any errors or inconsistencies you may have encountered with the materials. (Page numbers would 
be helpful.) 

20. What suggestions do you have for improving this Apple product? 



This book's binding lets it lie 
flat while you' re working 
with your Macintosh. When 
you're using the book, keep 
the wraparound end flap 
tucked inside the back cover. 
To make it easy to spot the title 
when the book 's on a shelf, 
fo ld the flap inside the front 
cover and set the book on the 
shelf with the title visible. 
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Limited Warranty on Hardware 
APPLE COMPUTER, INC. ("Apple"), warrants the Macintosh 
512K enhanced main unit, keyboard, mouse, and cabling 
against defects in materials and workmanship for a period of 
NINETY (90) DAYS from the date of original retail purchase. 

If you discover a defect, Apple will, at its option, repair, replace, 
or refund the purchase price of the product at no charge to you, 
provided you return it during the warranty period, 
transportation charges prepaid, to the authorized Apple dealer 
from whom you purchased it or to any other authorized Apple 
dealer within the country of original retail purchase. (You can 
obtain additional information from Apple directly at the address 
printed in the inside front cover of this manual.) Please attach 
your name, address, telephone number, a description of the 
problem, and a copy of the bill of sale bearing the appropriate 
Apple serial numbers as proof of date of original retail purchase 
to each product returned to warranty service. 

This warranty applies only to hardware products; Apple 
software media and manuals are warranted pursuant to a 
separate written statement. 

This warranty does not apply if the product has been damaged by 
accident, abuse, misuse or misapplication, has been modified 
without the written permission of Apple, or if any Apple serial 
number has been removed or defaced. 

ALL IMPLIED WARRAN~, INCLUDING IMPLIED 
W~OFMERCHANTABILTIYANDFI~SFORA 
PARTICULAR PURPOSE, ARE LIMITED IN DURATION TO 
NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL 
RETAIL PURCHASE OF TIDS PRODUCT. 

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE 
EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR 
WRITIEN, EXPRESS OR IMPLIED. No Apple dealer, agent, or 
employee is authorized to make any modification, extension, or 
addition to this warranty. 

APPLE IS NOT RESPONSIBLE FOR SPECIAL, INCIDENTAL, 
OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY 
BREACHOFWARRANTY,ORUNDERANYLEGAL 
THEORY, INCLUDING LOST PROFITS, DOWNTIME, 
GOODWILL, DAMAGE TO OR REPLACEMENT OF 
EQUIPMENT AND PROPERTY, AND ANY COSTS OF 
RECOVERING, REPROGRAMMING, OR REPRODUCING 
ANY PROGRAM OR DATA STORED IN OR USED WITH 
APPLE PRODUCTS. 

Some states do not allow the exclusion or limitation of implied 
warranties or liability for incidental or consequential damages, 
so the above limitation or exclusion may not apply to you. This 
warranty gives you specific legal rights, and you may also have 
other rights which vary from state to state. 

See inside front cover for warranty information on software 
media and manuals. 



® 

Apple Computer, Inc. 
20525 Mariani Avenue 
Cupertino, California 95014 
( 408) 996-1010 
TLX 171-576 

030-1326-A 


